Adobe Premiere Rush Help
Legal notices

## Contents

### Chapter 1: Introduction to Premiere Rush
- What is Adobe Premiere Rush ................................................................. 1
- Adobe Premiere Rush system requirements ........................................... 7
- What's new in Adobe Premiere Rush ..................................................... 11
- Get to know the Adobe Premiere Rush interface ................................... 14
- Keyboard shortcuts ................................................................................. 18
- Adobe Premiere Rush | Common questions .............................................. 21
- Tips and tricks ......................................................................................... 26
- How project syncing works in Adobe Premiere Rush ............................. 29
- Adobe Premiere Rush manual (PDF) ....................................................... 34

### Chapter 2: Import footage
- Import photos, videos, and audio ......................................................... 35

### Chapter 3: Edit video
- Edit your video in the timeline .............................................................. 43
- Add and refine audio .............................................................................. 47
- Adjust transitions, color, and size ......................................................... 54
- Create titles ............................................................................................ 60
- Create a picture-in-picture effect ............................................................ 66
- Speed up or slow down video ................................................................. 67
- Use fonts from Adobe Fonts ................................................................. 70
- Duplicate sequences ............................................................................. 72

### Chapter 4: Export video
- Save, share, or export your video ......................................................... 74

### Chapter 5: Premiere Rush on iOS and Android
- Adobe Premiere Rush on mobile | Common questions ............................ 77
- Create and edit videos using Adobe Premiere Rush on iOS .................. 81
- Export video ......................................................................................... 101
- Create and edit videos using Adobe Premiere Rush on Android .......... 103
- Manage Adobe Premiere Rush subscriptions on iOS ........................... 123
- Manage Adobe Premiere Rush subscriptions on Android ................. 132
- Manage Adobe Premiere Rush subscriptions on Samsung Galaxy Store ......................................................................................... 135

Last updated 11/27/2019
Chapter 1: Introduction to Premiere Rush

What is Adobe Premiere Rush

Premiere Rush is an all-in-one video creation tool that you can use to capture, edit, and share professional-looking videos quickly on your social channels, such as YouTube or Facebook.

Move seamlessly across devices (mobile or desktop) and feel confident that you can pick up where you left off with automatic project syncing. With a consistent experience across desktop and mobile devices, the power of Premiere Rush is available wherever you go.

What can I create with Premiere Rush?

Premiere Rush is ideal for creating short videos (~20 minutes or less) that you can share online with your social media followers or friends. Create and share content with high-quality motion graphics, audio, and color for YouTube, Facebook, Instagram, and more.

Get Premiere Rush on your devices

To use Premiere Rush, you need a computer (Mac or Windows), an iPhone, or an iPad.

1 See the Premiere Rush system requirements.
2 Download Premiere Rush on your devices: Desktop | iPhone or iPad

How do I get started?

Premiere Rush has an intuitive and easy-to-use interface. You can easily start your video editing journey in Premiere Rush and wow your followers on social media.

To get started, launch the product, and go through the one-minute interactive tutorial that walks you through the basics of editing your first video. The tutorial covers all of the key steps and features in Premiere Rush that you need to create and share your video.

Shoot videos and images or photos right from within the app or bring in media stored on your device. You can then edit the clips in Premiere Rush, refine color and audio with easy-to-use controls, and add titles, audio, and transitions. When your video is ready, save or export your video or share it directly on various social channels, such as YouTube or Facebook.

Additional Help and tutorials are always available on Adobe Premiere Rush Learn & Support.

Learn more and do more

Understand the video editing workflow and editing capabilities of Premiere Rush to make your videos stand out.
In a nutshell, the workflow in Premiere Rush includes the following steps:

- Capture footage or import media
- Edit, refine, and export video
- Export or share video

**Capture footage or import media**
You can capture footage using any phone, DSLR, or mirrorless camera and bring the footage into Premiere Rush. Premiere Rush automatically separates the scenes for you into clips.

You can also bring in audio files saved on your phone or use the Premiere Rush soundtracks that are available from within the product.

For more information on bringing footage into Premiere Rush and for information about supported file formats, see:

- Import photos, videos, and audio
- Supported video and audio formats for import

When using Premiere Rush on a mobile device (such as iPhones, iPads, or Android phones), you can use the capture experience built right into the product. This feature gives you access to more control if you need it and a seamless experience of bringing your captured media quickly into a project. You can then edit the video on your mobile device or switch over to Premiere Rush on your desktop. Projects sync seamlessly between desktop and mobile devices, so you always have access to your recent project edits across your devices, anywhere.

For more information on using the Premiere Rush app on mobile, see:

- Create and edit videos using Adobe Premiere Rush on iOS
- Create and edit videos using Adobe Premiere Rush on Android

**Edit, refine, and export video**
You can edit and refine your videos in Premiere Rush in many ways. You have access to the same editing capabilities across your mobile and desktop devices.

After you have brought in your video clips, you can keep the good parts, cut out the slow or boring parts, shuffle scenes around, and add audio and animated titles or motion graphics.
Edit clips in the timeline

Edit your video in the timeline

After bringing your footage into your Premiere Rush project, you can view the clips in the timeline and make changes right there. You can add more clips, such as additional videos, images, graphics, or music. You can split clips, move them around, or trim them right in the timeline.

For more information, see Edit your video in the timeline.

Add and edit transitions

Add and edit transitions

Add transitions between clips to smoothly move from one clip to another. Generally, you use a simple cut to move from shot to shot, but you can also add transitions between shots by phasing out one and phasing in another.

Premiere Rush provides a few transitions that you can apply to your clips to enhance your video. For more information, see Add and edit transitions.
Add and edit titles

Easily add text overlays and animated motion graphics to your videos, and customize things like font, font style (bold/italic/underline), font size, and color. Easily edit text, and move, scale, and rotate title and graphic templates directly on the Preview monitor.

Take advantage of the professionally designed built-in Motion Graphics templates and access more customizable animated titles, lower-thirds, transitions, and graphics from Adobe Stock right from within the app.

For more information, see Create titles.

Add audio clips or record voiceovers

Import music and audio clips into your Premiere Rush projects. Or, you can record voiceovers directly into your timeline.

Premiere Rush also comes with 10 royalty-free soundtracks that you can import and use in your video.

For more information, see Add and refine audio.
Adjust color

Premiere Rush includes several color presets that you can easily apply to clips to give them a certain look and feel. Click a color preset to apply it to your selected clip, and if you like you can tweak the intensity of the preset.

You can also use additional editing tools to refine color further.

For more information, see Adjust a clip's color.

Adjust speed

Speed up or slow down your videos to highlight impactful moments and add drama to your video.

For more information, see Speed up or slow down video.
Crop, scale, feather, and tweak opacity

You can transform your clips in multiple ways. You can position your clips, change their height, width, or opacity, and crop or rotate video using Premiere Rush's transform controls.

You can also feather (smooth or blur the edges of your video) your clip. Feathering is a great technique to spotlight the middle of the video frame, and focus the viewer's attention to that point.

For more information, see Adjust transitions, color, and size.

Export or share video

After you have completed creating your video, you can save it on your computer or directly share it on social media channels, such as YouTube, Facebook, Instagram, or Behance.

For more information, see Save, share, or export your video.

Step up from Premiere Rush to Premiere Pro

Premiere Rush is compatible with Premiere Pro. You can effortlessly open your Premiere Rush projects in Premiere Pro and take advantage of a greater variety of transitions and effects, more powerful color-correction and audio tools, multicamera editing, and a universe of third-party plug-ins.

For more information, see Open Premiere Rush projects in Premiere Pro.

Note:

Once a Premiere Rush project is opened in Premiere Pro, you cannot bring it back into Premiere Rush. This is because not all of the advanced editing controls in Premiere Pro are supported in Premiere Rush.
Adobe Premiere Rush system requirements

**Applicable for:** April, May, June, July, August, September, October, and November 2019 releases (versions 1.1.x and 1.2.x)

**Note:**

To install and use Adobe Premiere Rush, you need Windows 10 (v1709 or later), or macOS 10.13 or later.

Adobe Premiere Rush is not supported on Windows 7, Windows 8.x, Windows 10 (v1511 and v1607), or macOS 10.11 (El Capitan) and 10.12 (Sierra).

**Upgrade your operating system**

- **macOS**

  In order to take advantage of the latest operating system features and technologies, Adobe Premiere Rush requires macOS High Sierra (10.13) or later. If you’re on an older version of Mac OS X, Apple provides a free update to macOS High Sierra (10.13).

  [Click the image to start the update process]

- **Windows 10**
In order to take advantage of the latest operating system features and technologies, Creative Cloud 2019 apps require Windows 10 Creators update (version 1703) or later. If you’re on an older version, Microsoft provides a free update to the latest version of Windows 10.

For more information, see How to update to the latest version of Windows 10.

• **Windows 8.1**


To take advantage of the latest features in the Creative Cloud 2019 apps, you’ll need to upgrade your OS to a compatible version of Windows 10. If you’re unable to upgrade to Windows 10 right now, you can continue to work with previous versions of Creative Cloud apps. However, you won’t be able to use newly introduced apps, such as Premiere Rush or Adobe XD.

For upgrading options from Windows 8.1, contact Microsoft Support or your Microsoft reseller.

• **Windows 7**

The latest versions of the Adobe video and audio tools require Windows 10 (version 1703 or later). Performance and stability are top priorities for all of our users. Running our apps on current version of the Windows 10 helps provide an optimal experience with our tools.

Mainstream support for Windows 7 support ended in 2015. For more information on Windows support, visit the Windows lifecycle fact sheet.

For upgrading options from Windows 7, contact Microsoft Support or your Microsoft reseller.
# Minimum system requirements for Premiere Rush

## Windows

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Minimum requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Multicore processor with 64-bit support (Recommended: Intel Core i5 or i7, or equivalent)</td>
</tr>
<tr>
<td>Operating system</td>
<td>Microsoft Windows 10 with 64-bit support (Version 1709 or later)</td>
</tr>
<tr>
<td></td>
<td>For information on upgrading your Windows OS version, see <a href="#">Get Windows 10</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are unable to upgrade your operating system because of hardware limitations, you can still use Adobe Premiere Rush on iOS. For more information, see the iOS system requirements.</td>
</tr>
<tr>
<td>Device driver</td>
<td>Intel® Graphics Driver for Windows® (version 25.20.100.6326)</td>
</tr>
<tr>
<td>RAM</td>
<td>8 GB of RAM</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>8 GB of available harddisk space for installation; extra free space required during installation (cannot install on removable flash storage devices)</td>
</tr>
<tr>
<td>Monitor resolution</td>
<td>1280x800 display (1920x1080 or larger recommended)</td>
</tr>
<tr>
<td>Sound card</td>
<td>Sound card compatible with ASIO protocol or Microsoft Windows Driver Model</td>
</tr>
<tr>
<td>Internet</td>
<td>Internet connection and registration are necessary for required software activation, validation of subscriptions, and access to online services.*</td>
</tr>
<tr>
<td>Optional</td>
<td>Adobe-recommended GPU card for GPU-accelerated performance</td>
</tr>
</tbody>
</table>

**Note:**

NVIDIA has publicly released windows ODE drivers that support the CUDA 9.2 SDK used in the latest release of Premiere Pro. This is not the Microsoft default driver, but you can download this driver directly from NVIDIA, [Version 411.63](#) (of the 410 series drivers).

## macOS

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Minimum requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Multicore Intel processor with 64-bit support (Recommended: Intel Core i5 or i7, or equivalent)</td>
</tr>
<tr>
<td>Operating system</td>
<td>macOS X v10.13 or later</td>
</tr>
<tr>
<td></td>
<td>For information on upgrading your macOS version, see <a href="#">Upgrade to macOS High Sierra</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are unable to upgrade your operating system because of hardware limitations, you can still use Rush on iOS. For more information, see the iOS system requirements.</td>
</tr>
</tbody>
</table>
Introduction to Premiere Rush

<table>
<thead>
<tr>
<th>RAM</th>
<th>8 GB of RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space</td>
<td>8 GB of available hard disk space for installation; extra free space required during installation (cannot install on a volume that uses a case sensitive file system or on removable flash storage devices)</td>
</tr>
<tr>
<td>Monitor resolution</td>
<td>1280 x 800 display (1920 x 1080 or larger recommended)</td>
</tr>
<tr>
<td>Sound card</td>
<td>Sound card compatible with Apple Core Audio</td>
</tr>
<tr>
<td>Internet</td>
<td>Internet connection and registration are necessary for required software activation, validation of subscriptions, and access to online services.*</td>
</tr>
<tr>
<td>Optional</td>
<td>Adobe-recommended GPU card for GPU-accelerated performance</td>
</tr>
</tbody>
</table>

iOS
• iOS 12 or later
• iPhone 7 and newer (devices with A9 ARM chip or higher)
• iPad (devices with A9 ARM chip or higher)

Android
• Operating system: Android 9.0 (Pie or P) and later
• All the following devices running Android 9.0 and later are supported:
  • Samsung Galaxy S10/10+, S9/9+, S8/8+, A50, A70, Note 10/10+, Note9, Note8
  • Google Pixel 3/3XL, 2/2XL, 1/1XL
  • OnePlus 7/7 Pro, 6/6T devices, 5T
  • Sony Xperia 10/10+, XZ Premium, XZ3, XZ2, XZ1
  • Xiaomi Mi 9, Mi 8, Pocofone F1, Redmi Note 7/7 Pro

Language versions available for Premiere Rush
Adobe Premiere Rush is available in the following languages:
• English
• French
• Spanish
• German
• Korean
• Japanese

Note:
Adobe Creative Cloud services are currently not supported in the 1.1 version of Premiere Rush in China. As a result, Premiere Rush will not be available in this region.
What's new in Adobe Premiere Rush

Top new features

November 2019 release (version 1.2.13)

Ability to share directly to TikTok (iOS and Android)

You can now easily share your edited videos directly to TikTok.
August 2019 release (version 1.2)

Ability to change the speed of video clips

You can now do slow-motion, fast-motion, and re-time video and audio clips right within Premiere Rush

April and May 2019 releases (version 1.1)

Premiere Rush for Android

Learn about the all-new release of Premiere Rush for Android including a full list of supported devices.
Introduction to Premiere Rush

Experience improvements (iOS)
Learn about the user interface improvements in this release of Premiere Rush for iOS.

Support for new languages
Premiere Rush is now localized in Spanish and Korean.

New Motion Graphics templates available in Adobe Stock
Access new professionally designed Motion Graphics templates right within the app. Change the color, size, font, and more.

See detailed new feature summary

Previous releases of Premiere Rush
What is Adobe Premiere Rush
Get to know the Adobe Premiere Rush interface

Using Adobe Premiere Rush, you can arrange and edit clips to create and share great-looking videos.

You can edit your videos using all the editing elements that Premiere Rush provides within the Edit workspace. After you finish editing, you can share your videos using the Share workspace.

Home screen

When you launch Premiere Rush, the Home screen gives you quick access to create a new project, view online Help and tutorials, and interact with the Premiere Rush YouTube community. It also gives you easy access to all of your projects.

Premiere Rush Edit workspace

The Premiere Rush Edit workspace is where you create your video, editing clips in the timeline and using the refinement tools. In this workspace, you can customize your video by adding text, transitions, audio, color presets, and more.

Note:

All of the screenshots have been taken on a Mac. However, the Premiere Rush interface on Windows and iPads is similar.

If you are using Premiere Rush on iOS or Android phones, see:

- Create and edit videos using Adobe Premiere Rush on iOS
- Create and edit videos using Adobe Premiere Rush on Android
• **Home**: Takes you back to the Home screen where you can start a new project, and view or open all of your projects.

• **Edit**: Use the Edit workspace to edit your video - adding text, transitions, audio, color presets, and more.

• **Share**: Use the Share workspace to share your project on YouTube, Facebook, Instagram, or Behance. For more information, see **Save, share, or export your video**.

• **Titles**: Choose from a collection of built-in Motion Graphics templates. For more information, see **Create titles**.

• **Transitions**: Add transitions like fade in, fade out, or dissolve. For more information, see **Add and edit transitions**.

• **Color**: Add a color preset or create your own by adjusting exposure, contrast, highlights, and more. For more information, see **Adjust a clip’s color**.

• **Audio**: Adjust volume, mute, enhance voice, or auto-duck background music. For more information on audio, see **Add and refine audio**.

• **Transform**: Modify the appearance of your clip using crop, rotate, or scale, or do things like create a picture-in-picture effect. For more information, see **Transform a clip’s properties**.

• **Control Tracks**: Toggle tracks on/off, hide tracks, or lock tracks to make editing efficient.

• **Editing tools**: Split, duplicate, or delete a clip. You can also expand the audio tracks to make fine-tuning with audio easier. For more information, see **Edit your video in the timeline**.

• **Project panel**: View all of the videos, photos, audio clips, graphics, and sequences within your project.

• **Add**: Insert a title, more media, or a voiceover to your project. For more information on media, see **Import photos, videos, and audio**.
Premiere Rush Preview monitor

- **Timecode:** The timecode displays the exact time of the playhead position. It also displays the duration of the complete sequence.
- **Player Controls:** Play/pause the video, step forward/backward by one frame, or skip to the next/previous edit point.
- **View/Exit Full Screen:** Watch your video in full screen mode for a bigger preview.
- **Loop Playback:** Play the video on a loop to preview what it will look like on social media channels that auto-loop videos, such as Instagram.

You can change the orientation of your video and adjust your monitor display settings, using the following controls:

- **Orientation:** Choose Landscape, Portrait, or Square for your video.
- **Monitor Quality:** Choose between High, Medium, and Low settings when previewing your video in the monitor.
Premiere Rush timeline

The Premiere Rush timeline consists of the playhead to view/scrub your timeline and multiple tracks where your media is arranged.

Tracks

Tracks allow you to arrange your clips (videos, photos, graphics, and audio) with flexibility.

While editing a video, you can use multiple tracks primarily for situations like when you want to add music alongside your video or add a title that plays on top of your video.

The Premiere Rush timeline consists of one main V1 track. When you import video footage or still images, they are all by default arranged on this V1 track. If you import audio files, or add titles, they are placed in separate audio tracks on the timeline.
In Premiere Rush, you can have a maximum of seven tracks on the timeline: four video tracks and three audio-only tracks. Video tracks support video (with or without audio), images, and graphics. Audio-only tracks support audio-only clips like music and voiceover recordings.

Each track has controls on the left (when the Control tracks icon is clicked) that allow you to lock a track (to prevent inadvertent edits to it), mute the audio of a track, and show or hide a track.

**Playhead**

The playhead is the blue vertical line that shows you where you are in your timeline when you are previewing your video. The playhead is an essential element to make sure that you are editing and viewing the correct part of your video.

When you click a clip in the timeline, the playhead jumps to that location so that you can preview that selected clip in the monitor as you make edits or watch your video.

**Premiere Rush Share workspace overview**

The Premiere Rush Share workspace allows you to save your Premiere Rush project on your device or publish it on various social media channels, such as YouTube, Facebook, Instagram, and Behance.

If you want, you can adjust the preset, resolution, frame rate, audio channels, and the video quality of your final video, but Premiere Rush will automatically choose the highest quality settings based on the media within your project. Lastly, you can preview your video before you export it. For more information, see Save, share, or export your video.

**Keyboard shortcuts**

Adobe Premiere Rush provides shortcuts to help you quickly work on documents. Many keyboard shortcuts appear next to the command names in menus.
### Keys for File menu

<table>
<thead>
<tr>
<th>Command</th>
<th>macOS</th>
<th>Windows</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New &gt; Project</td>
<td>? + N</td>
<td>Ctrl + N</td>
<td></td>
</tr>
<tr>
<td>New &gt; Sequence</td>
<td>? + ? + N</td>
<td>Ctrl + Alt + N</td>
<td></td>
</tr>
<tr>
<td>Close Project</td>
<td>? + W</td>
<td>Ctrl + W</td>
<td></td>
</tr>
<tr>
<td>Share</td>
<td>? + E</td>
<td>Ctrl + E</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>? + Q</td>
<td>Alt + F4</td>
<td></td>
</tr>
</tbody>
</table>

### Keys for Edit menu

<table>
<thead>
<tr>
<th>Command</th>
<th>macOS</th>
<th>Windows</th>
<th>iOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>? + Z</td>
<td>Ctrl + Z</td>
<td>? + Z</td>
</tr>
<tr>
<td>* Cut</td>
<td>? + X</td>
<td>Ctrl + X</td>
<td>? + X</td>
</tr>
<tr>
<td>* Copy</td>
<td>? + C</td>
<td>Ctrl + C</td>
<td>? + C</td>
</tr>
<tr>
<td>* Paste</td>
<td>? + V</td>
<td>Ctrl + V</td>
<td>? + V</td>
</tr>
<tr>
<td>Select All</td>
<td>? + A</td>
<td>Ctrl + A</td>
<td>N/A</td>
</tr>
<tr>
<td>Deselect All</td>
<td>? + ? + A</td>
<td>Shift + Ctrl + A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Note:**

* These keyboard shortcuts are applicable for cutting, copying, and pasting text titles only.

### Keys for Clip menu

<table>
<thead>
<tr>
<th>Command</th>
<th>macOS</th>
<th>Windows</th>
<th>iOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split</td>
<td>S</td>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>Duplicate</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete &amp; Delete</td>
<td>Backspace &amp; Delete</td>
<td>Backspace &amp; Delete</td>
</tr>
<tr>
<td>Apply Transition</td>
<td>? + D</td>
<td>Ctrl + D</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Keys for Sequence menu

<table>
<thead>
<tr>
<th>Command</th>
<th>macOS</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Title</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>Add Voiceover</td>
<td>U</td>
<td>U</td>
</tr>
<tr>
<td>Add Media</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Zoom In</td>
<td>=</td>
<td>=</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### Keys for View menu

<table>
<thead>
<tr>
<th>Panel</th>
<th>macOS</th>
<th>Windows</th>
<th>iOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize Preview</td>
<td>'</td>
<td>'</td>
<td>N/A</td>
</tr>
<tr>
<td>Titles</td>
<td>? + 1</td>
<td>Ctrl + 1</td>
<td>? + 1</td>
</tr>
<tr>
<td>Transitions</td>
<td>? + 2</td>
<td>Ctrl + 2</td>
<td>? + 2</td>
</tr>
<tr>
<td>Color</td>
<td>? + 3</td>
<td>Ctrl + 3</td>
<td>? + 3</td>
</tr>
<tr>
<td>Speed</td>
<td>? + 4</td>
<td>Ctrl + 4</td>
<td>? + 4</td>
</tr>
<tr>
<td>Audio</td>
<td>? + 5</td>
<td>Ctrl + 5</td>
<td>? + 5</td>
</tr>
<tr>
<td>Transform</td>
<td>? + 6</td>
<td>Ctrl + 6</td>
<td>? + 6</td>
</tr>
<tr>
<td>Next Tool</td>
<td>? + ?</td>
<td>Ctrl + ?</td>
<td>N/A</td>
</tr>
<tr>
<td>Previous Tool</td>
<td>? + ?</td>
<td>Ctrl + ?</td>
<td>N/A</td>
</tr>
<tr>
<td>Track Controls</td>
<td>? + T</td>
<td>Ctrl + T</td>
<td>? + T</td>
</tr>
<tr>
<td>Expand Audio</td>
<td>? + R</td>
<td>Ctrl + R</td>
<td>? + R</td>
</tr>
</tbody>
</table>

### Keys for Timeline

<table>
<thead>
<tr>
<th>Command</th>
<th>macOS</th>
<th>Windows</th>
<th>iOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Next Edit Point</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td>Go to Previous Edit Point</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td>Go to End of Sequence</td>
<td>? + ?</td>
<td>Ctrl + ?</td>
<td>N/A</td>
</tr>
<tr>
<td>Go to Beginning of Sequence</td>
<td>? + ?</td>
<td>Ctrl + ?</td>
<td>N/A</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Space</td>
<td>Space</td>
<td>Space</td>
</tr>
<tr>
<td>Shuttle Left</td>
<td>J</td>
<td>J</td>
<td>N/A</td>
</tr>
<tr>
<td>Shuttle Right</td>
<td>L</td>
<td>L</td>
<td>N/A</td>
</tr>
<tr>
<td>Shuttle Stop</td>
<td>K</td>
<td>K</td>
<td>N/A</td>
</tr>
<tr>
<td>Step Forward 1 Frame</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td>Step Back 1 Frame</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td>Full Screen</td>
<td>`</td>
<td>`</td>
<td>`</td>
</tr>
<tr>
<td>Fit Sequence</td>
<td>\</td>
<td>\</td>
<td>\</td>
</tr>
</tbody>
</table>
Introduction to Premiere Rush

What is Adobe Premiere Rush?

Adobe Premiere Rush is the first all-in-one, cross-device app for creating and sharing online videos – fast. Edit, fix color, adjust audio, add titles, and more with easy-to-use tools, customizable Motion Graphics templates, and integration with Adobe Stock. And share your videos to your favorite social channels right from the app.

- **Easy editing:** With an intuitive interface and creative flexibility as you progress, Rush makes editing easy.
- **Simple timeline:** Arrange scenes with click drag-and-drop ease, access four video tracks, and three audio tracks without gaps in the timeline.
- **Customizable titles:** Easily add and customize built-in, professionally designed Motion Graphics templates. Hundreds more available on Adobe Stock.

### Keys for Large Preview

<table>
<thead>
<tr>
<th>Command</th>
<th>macOS</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark In</td>
<td>I</td>
<td>I</td>
</tr>
<tr>
<td>Mark Out</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Clear In</td>
<td>? + I</td>
<td>Alt + I</td>
</tr>
<tr>
<td>Clear Out</td>
<td>? + O</td>
<td>Alt + O</td>
</tr>
<tr>
<td>Clear In and Out</td>
<td>? + X</td>
<td>Alt + X</td>
</tr>
<tr>
<td>Deselect all items</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Back to grid view</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Add selection to timeline</td>
<td>? + Enter</td>
<td>Ctrl + Enter</td>
</tr>
</tbody>
</table>

### Keys for Media Browser

<table>
<thead>
<tr>
<th>Command</th>
<th>macOS</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deselect All items</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Enter Large Preview</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Select / Deselect Focused Asset</td>
<td>Z</td>
<td>Z</td>
</tr>
<tr>
<td>Select All Assets in Folder</td>
<td>? + A</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Deselect All Assets in Folder</td>
<td>? + ? + A</td>
<td>Ctrl + Shift + A</td>
</tr>
<tr>
<td>Add Selection to Timeline</td>
<td>? + Enter</td>
<td>Ctrl + Enter</td>
</tr>
</tbody>
</table>

Last updated 11/27/2019
• **Add audio:** Record voiceovers and use other simple tools like sound balancing, noise reduction, and auto-ducking to make your videos sound great.

• **One-click share to social:** Add a thumbnail, schedule your post, and publish to multiple social platforms in one click, without leaving Premiere Rush.

• **Available cross device:** Edit on your phone, tablet, or desktop. Your edits are automatically synced to the cloud, so you always have access to your latest versions.

• **Where can I find more information about Premiere Rush?**
  You can learn more about Premiere Rush on these web pages:
  
  • Visit the [Premiere Rush product page](#).
  • Follow Premiere Rush on [Facebook](#), [Twitter](#), and [Instagram](#), and [YouTube](#).
  • Subscribe to our [YouTube PlayList](#) for tutorials and inspiration from the community.

• **How do I download Premiere Rush?**
  Premiere Rush is available on Mac OS, Windows, and iOS.

  1. Mac OS or Windows
     The easiest way to install Premiere Rush is through the Creative Cloud desktop app – simply choose **Install** from the Apps tab. You can also download Rush from the product page.

     If you are a Creative Cloud for teams or Creative Cloud for enterprise member and you don’t have access to the Creative Cloud desktop app, contact your IT Administrator to obtain access to Premiere Rush through the Creative Cloud Packager.

  2. iOS
     Visit the Premiere Rush page on the [iTunes App Store](#) to download the Starter plan for free.

• **How do I get started using Premiere Rush?**
  Creating videos in Rush is quick and easy.

  Available right from the Welcome Screen, Premiere Rush comes with a guided interactive tutorial that walks you through the basics of creating your first video. Learn how to add clips, apply color filters, transitions, and more. To access the tutorial at any time:

  • iOS: From the projects screen, open settings (the gear icon). Then tap **Preferences** and select **Start tour again**.
  • Desktop: Click **Help > Start Tour Again**.

  You can also check out a series of step-by-step Get Started tutorials [here](#).

• **What are the minimum system requirements for Premiere Rush?**
  See the [Adobe Premiere Rush system requirements](#) for more information.

• **Where do I go to suggest features or report an issue with Premiere Rush?**
  Our team is actively listening to and responding to your feedback - you can look at existing feature requests and issues, vote on them, or add your own on our [UserVoice site](#).

• **Where do I get help and support for Premiere Rush?**
  Visit our [Learn & Support](#) page for help and tutorials.
Introduction to Premiere Rush

You can also connect with other creators using Premiere Rush on our support forums to share your experiences and get answers to questions.

• **In which languages is Premiere Rush available?**
  Premiere Rush is available in English, French, German, and Japanese. More languages coming soon.

• **Is Premiere Rush available in China?**
  Adobe CC services are currently not supported in the 1.0 version of Premiere Rush in China. As a result, Rush will not be available in this region.

• **How does Premiere Rush work with Premiere Pro?**
  Premiere Rush projects can be opened natively in Premiere Pro for continued editing. To open a Rush project in Premiere Pro, select **Open Rush Project** from the Start screen in Premiere Pro.
  Premiere Pro projects cannot be opened in Premiere Rush.
  For more information, see **Open Premiere Rush projects in Premiere Pro**.

• **How much does Premiere Rush cost?**
  Premiere Rush is available for free as part of a Starter plan and there are also paid plans available. Visit the compare plans page to see the different paid plan options.

• **What is the free Starter plan?**
  This free plan is available to anyone with a free Creative Cloud membership and includes Premiere Rush, 2 GB of Cloud Storage, and up to three exported projects. Start Premiere Rush for free [here](#).

• **What is an export? How many do I get for free?**
  An export is the way that a Rush project becomes a video that can be saved or shared. Any time that you want to save a video you've created in Rush on your computer or mobile device, or share it to social media, you must export it first. If you are on the Starter plan, you can only export up to three projects. To export more than three projects, upgrade to a paid plan.

• **How do I upgrade from the Starter version to the paid plan?**
  For more information on upgrading Premiere Rush, see **Upgrade from the Starter plan to the paid plan**.

• **Which paid plans include Premiere Rush?**
  Premiere Rush is included in the following plans:
  • **The Premiere Rush Single App plan** includes Premiere Rush with unlimited exports, 100 GB of cloud storage, Adobe Fonts, Adobe Portfolio, and Adobe Spark with premium features.
  • **The Premiere Pro plan** includes Premiere Pro and Premiere Rush - with unlimited exports, 100 GB of cloud storage, Adobe Fonts, Adobe Portfolio, and Adobe Spark with premium features.
  • **The Creative Cloud All Apps plan** includes all of the creative applications (Premiere Rush, Premiere Pro, After Effects, Photoshop, Illustrator, and more) required to create professional videos and images, plus 100 GB of cloud storage, Adobe Fonts, Adobe Portfolio, and Adobe Spark with premium features.

• **Does Premiere Rush come with the Premiere Pro Single App plan?**
  Yes, Premiere Rush is included in the Premiere Pro Single App plan.

• **Is Premiere Rush available in the Student, Creative Cloud Team, and Enterprise plans?**
  Yes, Premiere Rush is available in the Student, Creative Cloud Team, and Enterprise plans.

• **How do I cancel my Premiere Rush plan on mobile?**
For information about cancelling your Premiere Rush subscription, see:

- For iOS, see Manage Rush subscriptions on iOS.
- For Android, see Manage Rush subscriptions on Android.
- If you have installed the application on your Samsung device using the Galaxy Store, see Manage Rush subscriptions on Samsung Galaxy Store.

**How does Premiere Rush make it possible to work across mobile and desktop devices?**

When you create a synced project in Premiere Rush, a copy or proxy of the media is uploaded to Creative Cloud automatically. Your other devices can then access that media in Creative Cloud, which seamlessly allows you to continue editing the project.

![Creating a synced project in Premiere Rush](image)

**How much cloud storage does Premiere Rush provide? Can I upgrade my storage?**

The amount of cloud storage depends on your Creative Cloud membership. You can check on your available storage space on both iOS and desktop:

- iOS: From the projects screen, open settings (the gear icon). Then tap on your name.
- Desktop: Open the Creative Cloud desktop app and click the three dots next to your avatar in the upper right corner.

For more information about upgrading your storage, see Adobe Premiere Rush file storage requirements and upgrades.

**How can I optimize my storage space?**

You can optimize storage space by changing the sync settings of any projects you no longer want to edit across devices or by deleting them. In Your Projects (home button), select the three dots underneath a project’s thumbnail to either turn off sync or delete it. Either of these options remove any media associated with that project from Creative Cloud and reduce the amount of storage you are using.

*Note:*

*Turning off sync prevents you from working across devices, and deleting a project is permanent, irreversible, and prevents you from accessing it again.*

**How do I turn off cloud sync?**

To turn off cloud sync when you are first creating a project, deselect **Sync with Creative Cloud** on the Project Creation screen.
Creating a synced project

To turn off sync for an already created project, you can do so from the three dots underneath the project thumbnail in Your Projects (home button).

- **What happens to my videos and assets if I close or delete my Adobe account?**
  Account deletion is permanent and irreversible. Before you close your account, make sure that you have downloaded all your synced videos and assets stored in the cloud and exported and saved any completed videos from Rush.

- **What happens to my videos if I exceed my allotment of cloud storage?**
  If your storage space is exceeded, you can still use Rush and create projects. However, new projects and any media you add to new or existing projects do not sync to Creative Cloud. So, any devices other than the one where the clips are created/located cannot be used. Any media that you add before running out of storage space is available for you across devices (unless the project was deleted or project syncing was turned off).

- **What is the legal status of the soundtracks included with the app?**
The soundtracks provided in Premiere Rush can be used freely for personal or commercial use. See the Adobe Terms below.

Your use of the soundtracks is covered in section 2.5 of the Adobe Terms of Use (http://www.adobe.com/legal/terms.html). You can include the soundtracks as part of a Premiere Rush project for your clients, but you cannot distribute (or make them available) on a stand-alone basis.

To use a soundtrack from Rush, select **Rush Soundtracks** from the **Favorites** section of the Media Browser.

---

**Capture stable video**

Use a tripod to capture steady video.
Introduction to Premiere Rush

If you are on the go, look out for options to use the ground, a wall, or another object to brace the camera and get interesting visual perspectives.

Consider the final output while filming

If you are planning to create a YouTube video, shoot the video in landscape mode. If you want to share your videos on Facebook Stories or Instagram Stories, then capture in portrait mode.

If you are not sure where you will be posting the video, you can shoot in landscape and then change the video aspect ratio in Premiere Rush later.

For more information, see Change video aspect ratio.

Use the Premiere Rush app to capture video

Premiere Rush offers advanced video capture capabilities that provide you DSLR-like options to adjust ISO, white balance, shutter speed, frame rate, and more.

For more information, see Create and edit videos using Adobe Premiere Rush on iOS.

Use the grid

Use the grid to implement the rule of thirds while capturing video. The rule of thirds is a key technique to improve the composition and balance of your images. When you shoot in Premiere Rush, you can enable the grid by clicking the grid icon at the top of the screen. Once the grid is enabled, you can align the subject of your photo or video along the grid lines to follow the rule of thirds.

Go easy on the zoom

If you are filming using your the camera on your mobile phone, try to move closer to what you are filming rather than zooming in, which can cause a loss in quality.

If moving closer to the action is not an option, consider whether you can crop the footage while editing. For more information, see Transform a clip's properties.

Do an audio check before recording

If you plan to record sound with your video, make sure you do a quick sound check before starting to capture video. Doing a sound check makes you aware of any ambient noise or weird echoes that the camera is picking up. Note, you can always edit out background noise and remove echoes while editing. For more information, see Refine audio clips.
Introduction to Premiere Rush

Last updated 11/27/2019

Editing videos

Use keyboard shortcuts

Learn the keyboard shortcuts you can use for editing. Knowing the keyboard shortcuts can speed up your editing workflows. For more information, see Keyboard shortcuts.

Add music or narration

Adding music or a narration (also called a voiceover) is the easiest way to add depth and layers to your video. Take advantage of the free soundtracks available with Premiere Rush, or add your own music. You can also record voiceovers while editing your video. For more information, see Add and refine audio.

Create design thumbnails and titles that pop

Your video thumbnail and title is what gets viewers to click on your video (if you are sharing on YouTube). Use a high-quality still image or a frame from within your video as your thumbnail. Also, make use of professionally-designed Motion Graphics templates available on Adobe Stock from within the Titles panel to make your videos stand out. Once you've added and customized your Motion Graphics template to fit your video, you can use that frame showing your title as your thumbnail. For more information, see Share your video on your YouTube channel.

Add interest to your videos by creating cool cutaway or picture-in-picture effects

Showing footage from just one angle can be monotonous for the viewer. Try creating cutaway shots or picture-in-picture effects by adding a clip above another clip on the timeline to show two different perspectives of a single event. For more information, see Create a picture-in-picture effect.

Ask your viewers to subscribe to your channel

When you upload a new video to YouTube, add a call to action to your viewers to subscribe to your channel. There are some in the Adobe Stock tab in the Title panel; check them out! Also, consider including a note in the description asking your viewers to subscribe to your channel if they like your video.
How project syncing works in Adobe Premiere Rush

Syncing your projects in Premiere Rush lets you create, edit, and share your videos anywhere. When sync is enabled, files are saved in Creative Cloud. You can access these files from any device. All changes you make in Premiere Rush on your mobile device are reflected on the desktop. Similarly, any changes you make in Premiere Rush on the desktop are synced on mobile. You always have access to your latest edits wherever you go. It is a great way to save storage space on devices.

When you create a project in Premiere Rush, you can Sync to Creative Cloud from the Media Browser screen. When this option is selected, the project is saved to the cloud and is available for editing on other devices. This preference is enabled by default, but you can deselect it and create local device projects only as well.

Syncing on mobile (iOS and Android)

When a project is created with the Sync with CC preference enabled, media imported from a local device source is uploaded to a folder in your Creative Cloud account. It ensures that the media for this project is available on other devices running Premiere Rush (where you are logged into the same Creative Cloud account).

Creating a synced project on mobile

By default, the Sync with CC preference is turned on while adding media to your project. If you had turned it off but would like to access your project on another device, tap the three dots next to your project on the Project Browser screen and tap Turn Sync On. All of your projects are linked to your Adobe ID.

Turn Sync On

Note:

If you use multiple Adobe IDs and want to sync projects across multiple devices, make sure that you are logged into the same Adobe ID account in Premiere Rush on all of your devices. On a given device, you see only the projects for the account that Premiere Rush is logged into.

When you open the project, a blue circular icon appears in the upper right title bar of the application. This icon shows progress of the upload.

When this progress is complete, it means that Adobe has uploaded all media in your project. At this point, you can open the project on other devices. If you see an upload error dialog, when your Internet connection is stable, close and then reopen the project. The media is uploaded successfully.
Note:

By default, Premiere Rush does not upload media unless you are connected to a WiFi network. If you want to upload media over your cellular network, do the following.

1. Open Premiere Rush and see the Project Browser.
2. Tap the gear icon in the upper left.
3. Choose Preferences.
4. Enable Use Cellular For Sync.

Guidelines

To ensure that syncing occurs smoothly, follow these guidelines:

- If you close the project while media is uploading, the media upload continues. However, there is no indication of the media upload progress on the project browser. To check if the media upload has completed, reopen the project.
- If you switch away from Premiere Rush while media is uploading, it pauses. Premiere Rush continues uploading when the app is brought back to the foreground. If you receive a call or message while uploading, switch back to Premiere Rush to let the upload finish before attempting to open your projects on another device.
- When opening a project that was created on a different device, Premiere Rush downloads the necessary media for the project. You can observe the download progress by tapping the circular blue progress bar in the title bar, while the project is open.
- If you switch away from Premiere Rush while media is downloading, it can fail if Premiere Rush is downloading from Creative Cloud Files. If this scenario occurs, close the project, and reopen it.
- Always close your project on any device you are using, before you open the project on another device.

If your media has already been synced on mobile, but media is still shown as offline in Premiere Rush, do the following:

1. Make sure that you are connected to a strong WiFi network (or you have enabled Use Cellular For Sync and remember to leave Premiere Rush open and in the foreground until the download is complete).

Close Premiere Rush.
Launch Premiere Rush and open your project again.

Syncing on desktop (Mac and Win)

When a project is created with the Sync to Creative Cloud preference enabled, Premiere Rush creates optimized media and saves it to a folder in your Creative Cloud account. Unlike mobile, the Premiere Rush desktop application does not sync, upload, or download media, but instead creates optimized files that can be imported on other devices.
Creating a synced project on desktop

By default, the **Sync with Creative Cloud** preference is turned on while adding media to your project. If you had turned it off but would like to access your project on another device, tap the three dots next to your project on the Project Browser screen and tap **Turn Sync On**. All of your projects are linked to your Adobe ID.
Guidelines

To ensure that syncing occurs smoothly, follow these guidelines:

- Ensure that Premiere Rush completes creating optimized media for all files in your project.
- Check the Creative Cloud application on your Mac or Windows toolbar or taskbar and confirm that the media has been uploaded on the original mobile device or desktop machine.
- Close the project on any device you are using before you open the project on another device.
- On other desktop machines, check the Creative Cloud application in your Mac or Windows toolbar/taskbar and confirm that the media has been downloaded before launching Premiere Rush or opening your newly created projects.

If your media is already synced on desktop, but media is still shown as offline in Premiere Rush (or your list of Projects are not loading), do the following:

2. Log out of the Creative Cloud application.
3. Close the Creative Cloud application.
4. Relaunch the Creative Cloud application and log into your Creative Cloud account.
5. Launch Premiere Rush and to open your project again.
Sync status
A synced project is saved in Creative Cloud, making it available for you to edit on all of your devices. A project that is not synced can only be opened and edited on the device on which it was created.

In the Your Projects screen, you see icons next to the project name that indicate the sync status of the project.

To understand your project’s sync status, see the icons and descriptions in this table.

<table>
<thead>
<tr>
<th>Sync Icon on mobile</th>
<th>Sync icon on desktop</th>
<th>Project Sync Status</th>
<th>What happens when you tap or click the project?</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Sync Icon" /></td>
<td><img src="image" alt="Sync Icon" /></td>
<td>Device only and not in the cloud, so this project cannot be accessed on other devices</td>
<td>Project remains only on this device until you turn on sync. Turn syncing on for this project by going to Your Projects and tapping on &quot;•••&quot; &gt; &quot;Turn Sync On.&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Sync Icon" /></td>
<td><img src="image" alt="Sync Icon" /></td>
<td>Device and cloud, so this project can be accessed on all devices</td>
<td>Opens the project with the latest edits, whether those edits were made on this device or another device.</td>
</tr>
<tr>
<td><img src="image" alt="Sync Icon" /></td>
<td><img src="image" alt="Sync Icon" /></td>
<td>Cloud only and not currently on the device, but this project can be accessed on all devices</td>
<td>Downloads the project to the device and opens it.</td>
</tr>
<tr>
<td><img src="image" alt="Sync Icon" /></td>
<td><img src="image" alt="Sync Icon" /></td>
<td>Syncing in progress</td>
<td>Opens the project, and syncing to the cloud continues until completed.</td>
</tr>
</tbody>
</table>

Sync mismatch alerts
If the version of the project on your device is different from the project available on the cloud, Premiere Rush sends you an alert. You can either save a copy of your project in its current state, or overwrite it with the version saved on the cloud.

- Click Save copy: To create a copy of your project in its current state. Premiere Rush creates a copy of the project, so you have two separate projects in your project browser.
• Click **Overwrite**: To overwrite the currently opened project with the version of the project that exists in the cloud. It closes the currently opened project and takes you back to Your Projects so that you can open the most recent/cloud version of the project.

### Adobe Premiere Rush manual (PDF)

Find a PDF of articles to learn how to use Adobe Premiere Rush.

Adobe Premiere Rush manual (PDF)
Chapter 2: Import footage

Import photos, videos, and audio

You can bring your video clips, photos, graphics, and audio files from your computer or an external drive right into Premiere Rush and start editing your video project.

Media Browser
Media Browser is the panel in which you can browse, preview, and import various media types in Premiere Rush.

How to open Media Browser
When you create a new project, Media Browser opens automatically. You just need to select the media you would like to add to your project and click Create.

If you want to import media into an existing project, click the icon in the left toolbar to open Media Browser.
How to browse media in Media Browser

The left panel includes the following main sections:

- Local: Displays media saved on your local computer.
- Cloud: Displays media stored in the cloud such as in Creative Cloud or iCloud.
- Network (only shown if more drives are mounted to the device): Displays media stored in network-mounted drives.

The right panel displays your content.

You can use the Sort and Filter icons at the bottom in the window to sort and filter your media:

- Sort: Sort media on name or date of creation.
- Filter: Filter media by all media types, videos only, audio only, or images only.
Import footage

Create a project and add media files

When you launch Premiere Rush and start a new project, select and import your media. You can import media from your computer, a network location, or the cloud (such as Creative Cloud or iCloud). If you are connected to an office network, you can also import media from a network location.

1. On the Home screen, click Create a New Project.

2. In Media Browser, browse and select the assets you want to import in the order in which you want them to appear in the timeline.

Premiere Rush marks all the clips in the order you select them and arranges them at the bottom of the screen in a storyboard.

Add media files

If you are not satisfied with the order of the clips, you can deselect them by clicking them. Then select the assets again in the order in which you want them to appear.

3. (Optional) When adding an audio or video clip, you can choose to add only a part of the clip. For more information, see Add part of a clip.
4 (Optional) Select the following options:

- **Sync with Creative Cloud**: To save your video project to the cloud, select **Sync with Creative Cloud**. You can then access the project from all your mobile and desktop devices. All of your edits are synced to the cloud, so you always have the latest version of your project on any device.

- **Copy Media**: To save a copy of the selected media on your device, select **Copy Media**. This option is useful if you are importing media from a detachable device. Premiere Rush saves the media in the folder that you specify in the **Preferences** dialog box. By default, the media is stored in the **Premiere Rush/Imported Media** folder. For information about how to change this default location, see [Set audio, input, output, and rendering preferences](#).

5 **Click Create**.

After you click **Create**, Premiere Rush automatically adds all of your selected media to a sequence (by default, named Sequence 01), and the project is available for you to start editing in the **Edit** workspace.

**Add media files to an existing project**

1 To add media to your project while editing, click the icon in the left toolbar and select **Media**.

![Add media while editing](image)

2 Browse to find the media you want to add to your project.

3 Do one of the following:

   - Add the entire clip: Select the clip and click **Add**.
   - Add part of an audio or video clip: Select the clip and click the **Large Preview** icon. Play the media and select a range. Then click **Add**. For more information, see [Add part of a clip](#).

4 **Click Add**.

Premiere Rush adds the media that you have selected to the timeline. They appear where the playhead is positioned.

**Add part of a clip**

When you add media, you can choose to add only a part of a clip.

1 From **Media Browser**, select the media that you want to add.
2 Click the **Expand** icon to open a larger preview of the clip. Here you can play the clip and choose the portion you want to add to your project.

3 From the timeline, select the portion of the clip you want to add. Click the **icon**.

4 After selecting the portion of the clip, click **Add**.
**Set audio, input, output, and rendering preferences**

1. To open the Preferences dialog, choose **Edit > Preferences** (Windows) or select **Premiere Rush > Preferences** (macOS).

2. To change the location where Premiere Rush stores your copied media, click **Choose** in the Media Import area. Navigate to the folder where you want to save your media and click **Choose** again.

3. If you have multiple audio input and output options for your computer, set your input and output audio preferences. By default, Premiere Rush uses the built-in output and the built-in microphone for your system.

4. Select **Pre-render sequences for playback** if you are facing playback or performance issues. When this option is selected, Premiere Rush pre-renders parts of your sequence in the background to optimize playback.

5. To remove all cache files and free up disk space, click **Clear Cache**.

6. Click **OK**.

**Supported video and audio formats for import**

Premiere Rush supports several audio and video formats, enabling you to bring media from a large variety of devices for editing in Premiere Rush.

**Video formats**

<table>
<thead>
<tr>
<th>File format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple ProRes</td>
<td>Apple video compression format</td>
</tr>
<tr>
<td>DNxHD</td>
<td>Supported in native MXF and QuickTime wrappers</td>
</tr>
<tr>
<td>DNxHR</td>
<td>DNxHR LB, DNxHR SQ, DNxHR TR, DNxHR HQ, and DNxHR HQX</td>
</tr>
<tr>
<td>GIF</td>
<td>Animated GIF</td>
</tr>
</tbody>
</table>
### Import footage

<table>
<thead>
<tr>
<th>Format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>H.264 AVC</td>
<td>Any media that uses H.264 encoding</td>
</tr>
<tr>
<td>HEVC (H.265)</td>
<td>H.265 media with resolutions up to 8192x4320</td>
</tr>
<tr>
<td>M2T</td>
<td>Sony HDV from Sony Handycams</td>
</tr>
<tr>
<td>M2TS</td>
<td>Blu-ray BDAV MPEG-2 Transport Stream, AVCHD (from Sony Handycams)</td>
</tr>
<tr>
<td>M4V</td>
<td>MPEG-4 video file</td>
</tr>
<tr>
<td>MOV</td>
<td>QuickTime format</td>
</tr>
<tr>
<td>MP4</td>
<td>QuickTime Movie, XDCAM EX</td>
</tr>
<tr>
<td>MTS</td>
<td>AVCHD (broadcast format but also used in Canon camcorders)</td>
</tr>
<tr>
<td>MXF</td>
<td>Media eXchange Format. MXF is a container format that supports:</td>
</tr>
<tr>
<td></td>
<td>• P2 Movie: Panasonic OP1b variant of MXF video in AVC-Intra LT and</td>
</tr>
<tr>
<td></td>
<td>AVC-LongG, Panasonic Op-Atom variant of MXF video in DV,</td>
</tr>
<tr>
<td></td>
<td>DVCPRO, DVCPRO 50, DVCPRO HD, AVC-Intra</td>
</tr>
<tr>
<td></td>
<td>• Sony XDCAM HD 18/25/35 (4:2:0)</td>
</tr>
<tr>
<td></td>
<td>• Sony XDCAM HD 50 (4:2:2)</td>
</tr>
<tr>
<td></td>
<td>• AVC-LongGOP</td>
</tr>
<tr>
<td></td>
<td>• XAVC Intra</td>
</tr>
<tr>
<td></td>
<td>• XAVC LongGOP</td>
</tr>
<tr>
<td></td>
<td>• IMX 30/40/50</td>
</tr>
<tr>
<td></td>
<td>• XDCAM EX</td>
</tr>
</tbody>
</table>

### Audio formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAV</td>
<td>Windows Waveform</td>
</tr>
<tr>
<td>AIFF, AIF</td>
<td>Audio Interchange File Format</td>
</tr>
<tr>
<td>MP3</td>
<td>mp3 audio</td>
</tr>
<tr>
<td>M4A</td>
<td>MPEG-4 audio (iTunes format)</td>
</tr>
<tr>
<td>AAC</td>
<td>Advanced Audio Coding</td>
</tr>
</tbody>
</table>

### Still image formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP, DIB, RLE</td>
<td>Bitmap</td>
</tr>
<tr>
<td>GIF</td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td>JPEG</td>
<td>JPE, JPG, JFIF</td>
</tr>
<tr>
<td>PNG</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>PSD</td>
<td>Photoshop image format, flattened when it opens in Premiere Rush</td>
</tr>
<tr>
<td>HEIF</td>
<td>High Efficiency Image File Format</td>
</tr>
</tbody>
</table>
## Native camera formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARRI AMIRA camera</td>
<td>Premiere Rush provides built-in support for the ARRI AMIRA camera, with appropriate color LUTs applied as master clips on import.</td>
</tr>
<tr>
<td>Canon XF</td>
<td>You can work natively with Canon XF and Canon RAW footage, including footage from Canon Cinema EOS C300 and C500 cameras. Premiere Rush lets you natively import and edit QuickTime formats, including Apple ProRes and MOV files that Canon 5D and 7D cameras capture.</td>
</tr>
<tr>
<td>Panasonic AVC, P2 cameras</td>
<td>You can import and edit media from the following cameras/camera codec formats:</td>
</tr>
<tr>
<td></td>
<td>• Panasonic AVC Ultra</td>
</tr>
<tr>
<td></td>
<td>• Panasonic AVCi 200</td>
</tr>
<tr>
<td></td>
<td>• Panasonic AVC Ultra Long GOP (Group of Pictures)</td>
</tr>
<tr>
<td></td>
<td>• Panasonic P2 cameras and across multiple P2 cards</td>
</tr>
<tr>
<td>Sony cameras</td>
<td>You can import and edit media from the following cameras directly, without rewrapping or transcoding:</td>
</tr>
<tr>
<td></td>
<td>• Sony XDCAM</td>
</tr>
<tr>
<td></td>
<td>• Sony XDCAM 50</td>
</tr>
<tr>
<td></td>
<td>• Sony XAVC</td>
</tr>
<tr>
<td></td>
<td>• Sony XAVC LongGOP (Group of Pictures)</td>
</tr>
<tr>
<td></td>
<td>• Sony XAVC-S</td>
</tr>
<tr>
<td></td>
<td>• Sony SStP</td>
</tr>
</tbody>
</table>
Chapter 3: Edit video

Edit your video in the timeline

After you create a project in Premiere Rush, you can start editing your project in the timeline. Generally at this stage of editing, you trim clips, move them around, add more clips, or delete clips.

At this point in your editing workflow, the focus is not as much on enhancing your video (using techniques such as transition or color correction). The aim here is to make sure that your video follows a particular narrative in the order you want and that all extra footage is removed.

Here are some common tasks that you will perform while editing your video in the timeline:

- Move or rearrange clips
- Trim clips
- Split clips
- Duplicate clips
- Manage tracks

Premiere Rush timeline

Before you start editing, take a minute to become familiar with the Premiere Rush timeline and its capabilities.

The Premiere Rush timeline is a Non-Linear Editor (NLE). The timeline allows you to add, trim, split, duplicate, and arrange clips. You can arrange the media in any order and use additional tracks to stack or layer clips; you don’t have to put the media in the timeline in a sequential order.

Working with tracks in the timeline

In Premiere Rush, you can have a maximum of seven tracks in the timeline: four video tracks and three audio-only tracks. Video tracks support video (with or without audio), images, and graphics. Audio-only tracks support audio-only clips, such as music and voiceover recordings.

The main track is the video (V1) track. When you import video footage or still images, they are all by default arranged on this V1 track. If you import audio files or add titles, those clips are placed in separate tracks in the timeline.

The main V1 track is gapless. When you import footage, Premiere Rush automatically assembles all clips in this track next to one another with no gaps in between the clips. Similarly, when you remove a portion of the footage, the rest of the clips automatically align themselves leaving no gaps in the timeline. You don’t have to manually align clips. The V1 track is lighter in color than the other tracks.

Clips placed on tracks V2-V4 and A1-A3 are associated with clips in the main V1 track, keeping your clips in sync.

How Premiere Rush associates clips in the timeline

When you select a clip in the V1 track, clips that are associated with it in tracks V2-V4 and A1-A3 display a yellow line along their bottom edge. In addition, a vertical yellow line shows the connection point to the clip in the V1 track.
Visual indicators showing clips associated with a selected clip in the main V1 track

**Move or rearrange clips**

Click a clip that you want to move in the timeline; an orange border appears around the clip to indicate that it is selected. To select multiple clips, place your cursor and hold down to lasso multiple clips. Press the Ctrl or Command key and click individual clips to select multiple non-adjacent clips. For multiple, adjacent clips that are selected, you can drag the selected clips to a new location in the timeline to rearrange them. You can also move those clips to other tracks.

**TIP:** You can use this technique to create cutaway shots (for example, where you show two different perspectives of a single event).

**Trim clips**

You can fine-tune the duration of a clip in your timeline by moving the clip's start point or end point. This is called trimming.
Click on a clip to select it. Orange handles appear around the clip when it is selected. Click-hold and drag Go to the beginning or the end of the clip, hold the thick orange handle and drag it to the right to trim away a portion of the beginning of the clip.

Note:

Trimming clips does not trim the original video. You can drag the thick yellow line to the right to extend the trimmed clip at any time.

Split clips

Splitting is useful if you’ve added a clip to your timeline but don’t want to use the entire clip all at once.

To split a clip into two, select the clip in the timeline and drag the playhead to the place you want the split to occur (you can also use the < and > keys or zoom into the timeline to get a precise cut) and then click Split (the Scissors icon in the left toolbar).

After you split a clip, you can rearrange the two clips and move them around separately within your timeline.

Duplicate clips

Duplicating a clip before editing is a great idea as you can retain the original clip and do before-and-after comparisons while editing.

Select a clip in the timeline, and click the Duplicate icon in the left toolbar.

If the selected clip is on the main V1 track, Premiere Rush duplicates the clip and adds the new clip after the original clip in the timeline.

If the selected clip is an audio clip or a title, Premiere Rush duplicates the clip and adds the new clip at the exact spot as the original but in a new track.
Speed up or slow down clips

You can increase or decrease the duration of an entire clip or a selected portion of a clip. To select a portion of a clip, use the blue handles, then use the Range Speed slider to speed up or slow down the selected portion.

For more information, see Speed up or slow down video.

Manage tracks

You can hide tracks on the timeline to make editing easier on other tracks. You can also lock tracks to prevent changes.

To show and hide tracks: Click the Eye icon.

To lock and unlock tracks: Click the Lock icon.

To mute and unmute audio: Click the Loudspeaker icon.

Add clips

To add media clips to your project while editing, place the playhead on the timeline where you want to add the clip. Then click the + icon in the left toolbar, and select Media. Media Browser opens on the left of the application. Use the navigation buttons at the top to view folders and select your media. After you have selected all of your media, click Add.

Note:

Media Browser only displays files that are supported for import into Premiere Rush. For more information on supported file formats, see Supported video and audio formats for import.

Delete clips

To delete a clip, click the clip on the timeline to select it and click the Delete icon to the left of the timeline or press Delete on the keyboard.
Add and refine audio

Record audio

1. Position the playhead where you want to begin recording.
2. Click the blue + icon in the left toolbar and select Voiceover.

3. Click the Microphone icon in the audio track for which you want to record the audio. This turns the Microphone icon into a red button, which allows you to start and stop the audio recording.
4 Click the red **Record** button and wait for the 3-2-1 countdown to begin recording.

5 To stop the recording, click the same red icon.

The audio clip appears in the audio track, beginning where the playhead was originally positioned.
The audio clip is now attached to the corresponding clip in the main V1 track. If you move the clip in the V1 track, the audio clip moves as well. This audio clip is just like any other clip in your timeline, so you can trim, split, duplicate, or delete it. You can also add transitions to it or refine it further in the Audio panel.

**Add pre-recorded audio**

You can add sound effects and music to your videos. Premiere Rush provides a library of soundtracks to choose from, and you can also use audio files saved on your computer or in the cloud.

1. Position the playhead in the timeline where you want to add the audio.
2. Click the + icon in the left toolbar and select Media.
3 Browse to find the audio clip you want to add to your project.

4 Do one of the following:
   • Add the entire audio clip: Select the clip and click Add.
   • Add part of the audio clip: Select the clip and click the **Large Preview** icon. Play the audio and select a range. Then click Add.
The audio clip appears as a new track in the timeline where the playhead is positioned. The audio clip is now attached to a clip in the main V1 track. If you move the clip in the V1 track, the audio clip moves as well.

**Refine audio clips**

Use the Audio panel in Premiere Rush to refine your audio. This panel provides simple controls to repair sound, improve clarity, and add audio enhancements that help your videos sound professionally mixed.

1. Select the audio clip in the timeline and do the following basic adjustments:
   - Increase or decrease the audio volume of a clip by moving the **Clip Volume** slider.
   - Mute an audio clip by selecting **Mute**.

2. (Optional) Classify your audio clips as **Music**, **Voice**, or **Other**.

   **Note:**

   When you import a clip that has audio - such as an A/V clip or audio-only clip, Premiere Rush automatically detects and classifies the audio type as either **Voice**, **Music**, or **Other**. However, you can manually change the clip type.
After the clip is assigned an audio type (for example, Voice for a voiceover clip), the Advanced section of the Audio panel provides contextual controls for that audio type. This allows you to easily improve the way your audio clip sounds.

3 (Optional) Refine a voice clip.

If your audio clip is categorized as a voice clip, you can edit it using the following options:

- **Auto Volume** Select *Auto Volume* to automatically adjust volume levels (either up or down) so that the audio volume in your entire project sounds consistent.

  The *Auto Volume* option is turned on by default for all audio clips, so that any audio clip you bring into your project sounds great. You can turn this off by selecting the audio clip and deselecting the *Auto Volume* box.

- **Balance Sound** Select *Balance Sound* if you want to make quiet sounds louder and loud sounds quieter throughout your clip. This option can be especially useful if you have voices at different volumes within the same clip.

- **Reduce Background Noise** Select *Reduce Background Noise* to remove any steady state background noise from your clips. This option is useful when you want to remove air conditioning noise or any type of background hiss that is present in your audio clips. Use the *Intensity* slider to control the amount of noise removed.
Reduce Echo  Select **Reduce Echo** to remove any room reflections, echo, or reverberation from recordings. This option is useful when you want to remove the boxy, echoed sound that is common when recording in smaller or reverberant rooms. Use the **Intensity** slider to control the amount of echo and reverberation to remove.

Enhance Speech  Select **Enhance Speech** to apply a preset that improves the sound quality of a male or female voice.

4  (Optional) Refine a music clip.

If your audio clip is categorized as a music clip, you can edit it using the following options:

![Options to refine a music clip]

**Auto Volume**  Select **Auto Volume** to automatically adjust volume levels (either up or down) so that the audio volume in your entire project sounds consistent.

The **Auto Volume** option is turned on by default for all audio clips, so that any audio clip you bring into your project sounds great. You can turn this off by selecting the audio clip and deselecting the **Auto Volume** box.

**Auto Duck**  Select **Auto Duck** to automatically reduce the volume of music clips when voice clips (such as a voiceover or an A/V clip with voices) are present in your timeline. This option makes it easier to hear the voice clips, while music is playing in the background.

Premiere Rush automatically tracks any changes to audio clips in the timeline and adjusts the ducked portions of the music clip for you. Control the amount of auto-ducking using the **Reduce by** slider.

Moving the slider to the left with a lower value means that the music gets louder. Moving the slider to the right with a higher value means that the music gets quieter.

5  (Optional) Order or reorder audio channels.

(Only available on desktop) You can manipulate the audio channels within an audio clip. Twirl-open the Channels section of the Audio panel to see the channels within the audio clip, and reorder them by dragging them up or down.

You can also enable or disable audio channels by clicking the channel labels (for example, L or R).

**Remove audio**

To remove an audio clip from your project, select the clip in the timeline and click the **Delete** icon on the left, or press Delete on the keyboard.
Adjust transitions, color, and size

Add and edit transitions
You can add transitions between clips to smooth or blend the change from one video clip to another. You can have a clip cross dissolve into another clip, dip to black, or dip to white.

1 To add a transition to the start and end of a clip, select a clip in the timeline, and click any transition preset in the Transitions panel.

To add a transition to only one side of a clip, drag a transition from the Transitions panel and place it over the edge of the clip.

2 Adjust the duration of the transition by doing one of the following:
   • Select the transition in the timeline. In the Transitions panel, drag the Duration slider to adjust the duration.
   • Click the transition in the timeline to bring up orange handles around the transition. Drag the orange handles inward or outward to adjust the duration.
To delete a transition, select the transition in the timeline, and press Delete on the keyboard.

**Adjust a clip’s color**

You can adjust a clip’s color in multiple ways:

- Apply a color preset using one of the presets in the Color panel.
- Manually adjust exposure, contrast, highlights, shadows, temperature, tint, vibrance, saturation, and other color controls in the Edit tab of the Color panel.
- Do both. Apply a color preset and then refining its color properties in the Edit tab of the Color panel.

**Apply a color preset**

1. Select a clip in the timeline, open the Color panel, and click a preset.

2. Adjust the intensity of the preset by using the Intensity slider, at the bottom of the Presets tab.

3. To further edit the color properties, double-click the preset or click the Edit tab. Adjust the different color controls to achieve the effect you want.
Apply a color preset, tweak its intensity, and adjust its color properties

**Basic:**

- Exposure: Adjust the exposure of the clip.
- Contrast: Adjust the contrast of the clip.
- Highlights: Adjust the brightness of the light areas in the clip.
- Shadows: Adjust the darkness of the darker areas in the clip.
- Temperature: Fine-tune the white balance by moving the slider to the left to make the video appear cooler, and to the right for warmer colors.
- Tint: Fine-tune the white balance by moving the slider to the left to add a green tint, and move it to the right to add a magenta tint.
- Vibrance: Adjust the intensity of the more muted colors in the clip with less effect on the higher-saturated colors.
- Saturation: Adjust the saturation of all colors in the clip equally from 0 (monochrome) to 200 (double the saturation).

**Advanced:**

- Faded Film: Apply a faded film effect to the clip.
- Sharpening: Adjust edge definition to create a sharper-looking video.
- Vignette - Amount: Set the amount of lightening or darkening along the edges of an image.
- Vignette - Feather: Define the edge of the vignette. A smaller value creates a harder, sharper edge, whereas, a larger value indicates a softer, thicker edge.
Create presets
You can create and save your own custom presets for later use, which include the color preset and the settings from the Edit tab. The created presets are saved into the "Your Presets" section in the Presets tab.

To create a preset based on the color adjustments you've made in the Color panel, open the Color panel, choose the ••• (more options) button and select Create Preset.

Transform a clip's properties
You can modify the appearance of your clip by cropping, rotating, or scaling. To make these types of adjustments, select the clip in the timeline and open the Crop & Rotate panel. The adjustment settings are grouped into Basic and Advanced controls.

**Basic:**
The Basic controls let you adjust the position and scale of the clip.
Basic Transform settings

- **Horizontal Position**: Adjust the horizontal position of the clip.
- **Vertical Position**: Adjusts the vertical position of the clip.
- **Rotation**: Rotates the object 180° when dragging to the right and 180° when dragging to the left.
- **Scale (Maintain Proportions)**: This check box, when selected, adjusts the scale width and scale height uniformly. When the check box is Off, the width and height can be adjusted independently.
- **Scale Width**: Adjust the width of the clip.
- **Scale Height**: Adjust the height of the clip.

Here is an example showing how you can tweak some of these properties in your clip. For example, if you are creating a travel vlog, you can use these transform properties to remove unwanted elements (such as removing a face from your video) and change the focal point.
Use Transform controls to change the focal point of your video clip

**Advanced:**

The **Advanced** controls let you crop and modify the appearance of the clip.

**Crop:**

- **Crop Top:** Crop the top edge of the clip.
- **Crop Bottom:** Crop the bottom edge of the clip.
• **Crop Left**: Crop the left edge of the clip.
• **Crop Right**: Crop the right edge of the clip.

**Appearance**:

• **Opacity**: Adjusts the opacity and transparency of the clip. For example, 75% opacity equals 25% transparency. Playing with opacity allows you to create cool effects between clips on the timeline.
• **Edge Feather**: Applies an edge feather to all edges of the clip.

>Note:

The *Edge Feather* effect applies to the original edges of the object. If cropping is applied, edge feathering is not visible.

### Create titles

You can add a title to any video clip or photo in your Premiere Rush project. You can create simple text-only titles or jazzy titles with text, graphics, and animation using Motion Graphics templates. Premiere Rush lets you access a variety of Motion Graphics templates from the Titles panel.

When you add a title, Premiere Rush creates a clip with only the title. You can easily select a clip, and edit or delete the clip.

#### Titles panel

The **Titles** panel lets you choose from a large selection of built-in title styles. You can also find hundreds of title styles or Motion Graphic templates in Adobe Stock. After choosing a template, create your title by adding the text in a font of your choice. You can change the font color, size, and more. You can also tweak the graphics.

*Titles panel*

A Choose a template  
B Get a template from Adobe Stock  
C Add a template  
D Search for a template  
E Filter templates by all, recently used, your favorites (starred), or by Creative Cloud Library folders  
F Browse your templates
Create simple titles
You can add and edit titles using the Titles panel in Premiere Rush.

Add a title
1. Move the playhead to the spot where you want the title to appear in your video.
2. Click the blue + icon on the left toolbar, and select Title.

Premiere Rush adds a default title clip to your timeline, showing you a preview of it in your Preview monitor as well.

3. Select the title clip in the timeline and double-click the text in the Preview monitor to edit it.
4 To customize the appearance of the title, click the **Edit** tab. You can change the font, font size, and other format and appearance controls.
If you want additional font options, you can add fonts from Adobe Fonts. For more information, see Add fonts from Adobe Fonts.

**Change title style**
You can edit the text, font, size, color, and position of a title. You can also preview other title styles and change the title to a style you like better.

1. Select the title clip in the timeline, and click the **Titles** icon to open the **Titles** panel.
2. From the **Titles** panel, select a template with the style you want.
3. To further customize the title, select **Edit** in the **Titles** panel.
4. Select your text layer in the Preview monitor and then change the font, size, color, and other properties of your title.

**Adjust the position, size, and duration of a title**

1. Select the title clip in the timeline. Then click the Preview monitor to bring up blue handles that allow you to adjust the position and size of the title. You can move it anywhere on the monitor.

2. Adjust the duration of a clip by using the orange trim handles around the clip or by moving the clip around in the timeline.
Create titles using Motion Graphics templates

Motion Graphics templates are templates created by a Motion Graphics artist in Premiere Pro or After Effects. You can use these templates to create professional-looking titles, transitions, and other video elements in just a few steps.

Premiere Rush comes with a selection of built-in Motion Graphics templates for titles, which you can access from your computer. You can also browse Adobe Stock for hundreds of other options or use a shared Motion Graphics template from Creative Cloud Libraries.

Use Motion Graphics templates from Adobe Stock

Adobe Stock has hundreds of professionally designed Motion Graphics templates for titles, lower thirds, transitions, and graphics. From the Titles panel in Premiere Rush, you can browse Adobe Stock to find the template you want for your title. You can even license and customize the template from within Premiere Rush.

1 In the Titles panel, click Adobe Stock.
2 Enter your search term and press Enter.
3 Drag the Motion Graphics template to the timeline.

**Install Motion Graphics templates**

If you have Motion Graphics templates stored on your computer or in Creative Cloud Files, you need to install them from the **Titles** panel so you can access from within Premiere Rush.

When you install a Motion Graphics template, the template gets copied to the Local Templates folder in your installation of Premiere Rush.

1 To install a Motion Graphics template, click the ... icon.
2 Select **Install Template** (macOS), or **Import Template** (Windows).
3 Navigate to a Motion Graphics template you want to import.

This template is available to you in the **Titles** panel, and you can use it in any Premiere Rush project.
**Delete title clips**

To delete a title clip, select the clip in the timeline and click the **Delete** icon on the left toolbar.

---

**Create a picture-in-picture effect**

A picture-in-picture effect is when two videos or images are shown at the same time with one smaller video or image on top of a larger one. You can use this picture-in-picture effect to insert an additional video or image into your main video to help you further illustrate or highlight parts of your story.

Check out this video to learn how you can quickly create picture-in-picture effects using Premiere Rush.

Viewing time: 45 seconds

**Video**

To add a picture-in-picture effect:

1. If you don't have media on the V1 track laid out already, click the **icon** to import a media clip to the main V1 track on the timeline.

2. Click the **icon** again to import the image or video (that you want to be the smaller one on top) and place it on a track above the clip in the main V1 track. You can do this by clicking or tapping on the clip in the timeline and dragging it above the main V1 track.
3. Select the clip in the secondary track and resize or edit it just like you would edit any other video clip. Some edits you can make:

- **Resize the picture-in-picture clip**: Drag any of the clip's corners in the Preview Monitor.
- **Add cool transitions to the picture-in-picture clip**: Click the Transition menu and choose any of the available transitions. For example, you can have the smaller image or video fade in and out by adding a Cross Dissolve transition to the clip.

For more information on editing a clip's properties, see [Transform a clip's properties](#).

### Speed up or slow down video

#### Change video speed using Premiere Rush on desktop

**Video**

- **Increase or decrease the speed of a clip**
  1. In the timeline, select the clip you want to speed up or slow down.
  2. To show the speed controls, click the **Speed** button on the right bar.
  3. (Optional) To speed up or slow down only a portion of the clip, set the start and end points to select a specific range.
     - Set the start and end points using the **Range** slider in the Speed panel, or
     - Set the start and end points directly using the blue range handles on the clip in the timeline.
4 Move the Range Speed slider right to increase the playback speed of a clip. Move it to the left to slow it down. As you move the slider:

- The clip duration changes (under the Range Speed slider)
- A sped up clip becomes shorter in the timeline. A slowed down clip becomes longer.

5 If the clip contains audio, playing the clip more slowly lowers the pitch of the audio, and playing the clip faster raises the pitch. To preserve the original pitch of the audio, the Maintain Audio Pitch check box in the Speed panel is enabled by default. If you don’t want to preserve the pitch, disable this check box.
Tip: If the audio isn’t essential, mute the audio track and add background music to the clip.

6 To smooth the transition into your speed range, select Ramp and adjust the ramp duration.

• Edit clip duration to set a specific duration for your clip

If you are unsure of the clip speed that you want, you can manually edit the clip duration to set a specific duration for your clip and let Premiere Rush determine the right speed changes to make for you - based on that duration. To edit the clip duration, click the minutes, seconds, or frames values and type in your changes.

1 In the timeline, select the clip to which you want to apply speed changes.

2 To show the speed controls, click the Speed button on the right bar.

3 In the Clip Duration field, click the minutes, seconds, or frames values and type in your changes.

![Changing the clip duration](image)

• Remove speed adjustments from a clip

Click the Reset button to reset the range section to the default speed.

![Remove speed adjustments from a clip](image)

Change video speed using Premiere Rush on mobile

Video
You can change video speed using Premiere Rush on iOS or Android as well. For more information and step-by-step instructions, see:

- On iOS: Adjust speed
- On Android: Adjust speed

**Examples**

- **Convert long video clips into Insta-friendly short videos in one quick step**
  Instagram video clips need to be of a specific time duration. You can quickly set the clip duration using Premiere Rush.
  
  Video

- **Use ramp to make speed changes gradual**
  Video

**Best practices**

New to video editing? Here are a few guidelines to help you understand when to speed up or slow down your video.

**When to speed up video**

Often videos benefit from a faster pace in scenarios where you want to:

- Create a short video that might otherwise take a long time to watch, or is a good length for social media.
- Speed up slower moments in a video, but you don’t necessarily want to edit it out.

**Examples:** Arts and crafts videos, vlogs, make up tutorials

**When to slow down video**

Slowing down a video is a great idea if you’re looking to:

- Create a mood that’s thoughtful or dreamy.
- Emphasize details in fast-moving content that may otherwise be too quick for viewers to appreciate.

**Examples:** Sports videos

**Use fonts from Adobe Fonts**

A paid Premiere Rush subscription includes Adobe Fonts, which offers thousands of fonts from hundreds of type foundries. You can activate the fonts you want and add them to use in Premiere Rush.

**Add fonts**

1. Double-click the text in the timeline panel to open the Titles panel.
2. In the Font list of the Titles panel, click the Creative Cloud icon next to Add Adobe Fonts.
Premiere Rush takes you to the Adobe Fonts website.

3 Select the desired fonts and click **Activate**.

The Creative Cloud desktop app initiates the process and activates the fonts on your computer, making them available in the **Fonts** menu in Premiere Rush.

**Note:**

You can use filters so that only fonts from the Adobe Fonts library or your favorite fonts are displayed.

- To view only the fonts from Adobe Fonts that are activated to your computer, click the **Creative Cloud** icon.
- To view only the fonts that you have marked as a favorite, click the **Star** icon.
Duplicate sequences

Video

To duplicate a sequence, do the following:

1. Open the project in Premiere Rush.
2. Click the project bin icon. The Project Assets panel opens containing the media and audio clips used in the project.
3. Find your sequence. The clip has the sequence icon.
4. Click the more icon … and choose Duplicate from the pop-up list. A copy of the sequence is created.
5. Click the more icon … on the copied sequence and choose Rename. Type a name and click Rename.

The sequence has been duplicated with a new name. You can now make changes to the sequence. You can now transform, color correct, cut, all the changes you want in this new project.

Change aspect ratio

One reason for duplicating sequences is to create different versions of it to publish to various social channels.

The aspect ratio requirements for a video vary for different social media channels. You can change the aspect ratio and orientation of the video to suit each channel.
1 To change the aspect ratio of your video, click the icon at the bottom of the Preview monitor. Choose Landscape, Portrait, or Square.

2 (Optional) Adjust the scale and position of a clip in the Preview monitor, so that the focus is on the most important part of the clip.

- **Scale the clip:** Select the clip in the timeline, click the clip in the Preview monitor. Blue handles appear around the clip. To scale the clip, drag the white circles along the edges of the blue handles.

- **Reposition the clip:** Select the clip in the timeline and click the clip in the Preview monitor. Blue handles appear around the clip. Click drag-and-drop the clip to your desired position in the Preview monitor.

Change the orientation and focal point of a video clip
Chapter 4: Export video

Save, share, or export your video

Note:
If you are on the Premiere Rush Starter plan, you can export up to three videos. For unlimited exports, upgrade to a paid plan. For more information, see Upgrade from the Premiere Rush Starter plan to a paid plan.

Save video to your device
To save your video to your local device:
1 Click Share in the top toolbar.
2 Click Local.
3 Add the Filename and choose a location to Save to.
4 If you have a specific video requirement, you can tweak the advanced settings. For more information, see Advanced Settings.
5 Preview your video before you render and save it on your device.
6 Click Export.
Premiere Rush renders your video, using the export settings you have chosen and saves it in the location you have specified.

Share your video on your YouTube channel
You can sign in to YouTube from Premiere Rush and directly share your video on your YouTube channel.
1 Open the project in Premiere Rush.
2 Click Share in the top toolbar.
3 Click YouTube.
4 Sign in to YouTube (if you are not already signed in).
5 Select a Playlist. Add a Title, Description, and Tags to easily surface your video. Set Privacy settings to Public, Unlisted or Private.
6 You can choose to schedule when the video gets published to your YouTube channel by adding a date and time. You can also choose to keep a copy of the file on your device.
7 If you have a specific video requirement, you can tweak the advanced settings. For more information, see Advanced Settings.
8 Set the thumbnail. You can choose to Set Current Frame or select a Custom Thumbnail.
9 Preview your video before you render and export your video to YouTube.
10 Click Export.
11 Once rendering is complete, click Publish.

**Share your video on your Facebook page**
You can directly publish your video to a Facebook page. You can only share a video on Facebook if you have an account associated with a Facebook page.

1 Open the project in Premiere Rush.
2 Click Share in the toolbar.
3 Click Facebook.
4 Sign in to Facebook (if you are not already signed in).
5 Select a Page associated with your account. Add a **Title** and a **Description** to help viewers understand more about the video. You can choose to save a copy of the file on your device.
6 If you have a specific video requirement, you can tweak the advanced settings. For more information, see Advanced Settings.
7 Preview your video before you render and export your video to Facebook.
8 Click Export.
9 Once rendering is complete, click Publish.

**Export video to Instagram**
To export your video to Instagram, save the file on your device, log in to your Instagram account, and share the video from the Instagram app on your iOS device.

1 Open the project in Premiere Rush.
2 Click Share in the toolbar.
3 Click Instagram.
4 Sign in to Instagram (if you are not already signed in).
5 Select a location to save the file.
6 If you have a specific video requirement, you can tweak the advanced settings. For more information, see Advanced Settings.
7 Preview your video before you render and export your video to Instagram.
8 Click Export.
9 Once rendering is complete, click Done.

**Export video to Behance**
You can directly export your videos to Behance.

1 Open the project in Premiere Rush.
2 Click Share in the toolbar.
3 Click Behance.
4 Sign in to Behance (if you are not already signed in).
5 Add a **Description** and **Tags** to surface your videos on Behance. You can choose to save a copy of the file on your device.

6 If you have a specific video requirement, you can tweak the advanced settings. For more information, see **Advanced Settings**.

7 Preview your video before you render and export your video to Behance.

8 Click **Export**.

9 Once rendering is complete, click **Publish**.

**Advanced Settings**

The advanced settings default to the best settings based on the type of video and social media destination. You usually do not have to modify these settings, unless you have a specific video requirement.

The default **Preset** on all platforms is **Automatic** where **Resolution** and **Frame Rate** are set to **Automatic**, **Audio Channels** is set to **Stereo**, and **Quality** is set to **High**. However, you can select any preset from the drop-down list based on the nature of your video and your publish destination.

The following elements define a preset. When you change any of these elements, the preset automatically becomes a custom preset. After you create a custom preset, you can save the preset.

<table>
<thead>
<tr>
<th>Preset component</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Various resolution options are available depending on the type of video and publish destination.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Various frame rate options ranging from 23.976 fps to 60 fps are available.</td>
</tr>
<tr>
<td>Audio Channels</td>
<td>You can choose between mono, stereo, or no audio options.</td>
</tr>
<tr>
<td>Quality</td>
<td>Set the quality of the video. While setting the quality, keep in mind that high-quality videos take up more hard drive space and can take longer to load if viewed over the Internet.</td>
</tr>
</tbody>
</table>

To save a custom preset, click the **Save Preset** icon next to the **Preset** pop-up menu. Name your preset and click **OK**. Your custom preset is now available for you to use from the **Preset** pop-up menu.
Chapter 5: Premiere Rush on iOS and Android

Adobe Premiere Rush on mobile | Common questions

The Adobe Premiere Rush app on mobile allows you to capture and edit video on the go. If you also have Premiere Rush on desktop, all your projects are synced automatically to your desktop. This allows you to create videos anywhere and across your mobile and desktop devices.

Premiere Rush on mobile has the same features and capabilities as Premiere Rush on the desktop. One additional feature on mobile is the ability to capture videos and photos right from within the Premiere Rush app.

Here are answers to some frequently asked questions about Premiere Rush on mobile.

General information

- How can I get Premiere Rush on mobile?
  You can get Premiere Rush on iOS from iTunes. If you are on Android, you can get Premiere Rush from the Google Play Store or Samsung Galaxy Store.

- Do I need to use Premiere Rush on mobile along with the Premiere Rush app on desktop?
  Premiere Rush is built so that you can seamlessly move between editing on your desktop and mobile devices. You can use Premiere Rush only on desktop or mobile, or on both devices. All of your projects created in Rush can be accessed across your mobile and desktop devices. For more information on syncing, see How project syncing works in Premiere Rush.

- Can I download Premiere Rush on mobile for free?
  Yes. On your mobile device, you can download Premiere Rush for free from the iTunes App Store for iOS (iPhones and iPads) or the Google Play Store or Samsung Galaxy Store (Android phones). Once you’ve downloaded and installed the app, you can sign up for a free Adobe ID (if you don’t already have one). You can also sign in using your Google or Facebook credentials. With your free Adobe ID, you get 2 GB of cloud storage and the ability to export up to three videos.

- Which iOS and Android devices and operating systems can I use with Rush?
  See the Adobe Premiere Rush system requirements for iOS, Android, macOS, and Windows.

- Do I need a Creative Cloud account to use Premiere Rush on mobile?
  Yes, you need an Adobe ID account to use Premiere Rush.

- In which countries is Premiere Rush available on mobile?
  Premiere Rush on mobile is available in all countries supported by iTunes, the Google Play Store, or Samsung Galaxy Store.
Premiere Rush is not available in China. This is because Adobe Creative Cloud services are currently not supported in China. As a result, Premiere Rush is not available in this region.

In which languages is Premiere Rush available?
Adobe Premiere Rush is available in the following languages:
- English
- French
- Spanish
- German
- Korean
- Japanese

Using Premiere Rush on mobile

How do I learn to use Premiere Rush on mobile? Where do I go for help and support?
Get started with the app by going through the one-minute interactive tutorial that walks you through the basics of editing your first video. This tutorial covers all of the key steps and features in Premiere Rush that you need to create and share your video.

For further help on using Premiere Rush on mobile devices, see:
- Create and share videos using Adobe Premiere Rush on iOS
- Create and share videos using Adobe Premiere Rush on Android

How do I edit my video projects created in Premiere Rush on mobile on my desktop?
You don’t need to do anything. Projects on Premiere Rush are automatically synced to Premiere Rush on desktop (as long as you have a good Internet connection).

If you’re having issues accessing your projects across your devices, see How project syncing works in Premiere Rush.

Does Premiere Rush on mobile support editing in portrait and landscape orientations?
On the phone, you can edit your videos while holding your device in portrait mode or vertically. On an iPad, you can edit your videos while holding your device in portrait or landscape mode (vertically and horizontally).

Note:
Premiere Rush is currently not supported on Android tablets.

Can I import Super Slow-mo videos captured on my Android device into Premiere Rush?
Currently, Super Slow-mo videos are not supported and will not playback in Rush. We are working on adding support for Super Slow-mo videos in a future release.

Managing your Premiere Rush on mobile subscription

How do I upgrade from the Starter plan to the paid plan on mobile?
Tap the Settings icon in Premiere Rush on iOS or Android and then tap Upgrade. Tap Buy Now, and follow the prompts to purchase the paid Premiere Rush plan with 100 GB of storage and unlimited exports.
• How do I upgrade storage if I purchased the Premiere Rush plan from the Apple App Store, Google Play Store, or Samsung Galaxy Store?

If you purchased Premiere Rush from a mobile app store, you can buy additional storage from Adobe.

When you’re nearing the storage limit, you’ll see an in-app notification that prompts you to upgrade your storage.

You can then go to this link to upgrade your storage. In the screen that appears, enter your email address or Adobe ID, and click **Continue** to purchase additional cloud storage.

![Upgrade after getting an in-app notification on your Premiere Rush iOS or Android app](image)

**Note:**

*If extra storage is not available for purchase in your country, contact us to buy additional storage.*

**Note:**

*Your Premiere Rush subscription will still be billed from Apple, Google Playstore or Galaxy Store but you will receive a monthly charge from Adobe for the additional storage you have purchased. Contact us if you have any questions with this purchase.*

• How do I download and install Premiere Rush on my Samsung phone?

1. Launch the **Galaxy Store** app from your device.
2. In the **Galaxy Store**, search for **Premiere Rush**.
3. Tap **Install** to download and install the free Premiere Rush app.

• How do I cancel my Premiere Rush subscription if I purchased it from Samsung Galaxy Apps store?

To unsubscribe, go to the Galaxy Store. Tap **More Options > My Apps > Receipts > Items** and tap **Unsubscribe**.
How do I download and install Premiere Rush on my Android phone?
You can install Premiere Rush on your Android device just like you would install any other app. For more information, see the Google documentation: Get Android apps and digital content from the Google Play Store.

How do I cancel my Premiere Rush subscription if I purchased it from the Google Play Store?
For information on canceling your Premiere Rush subscription from Google Play Store, see: Cancel, pause, or change a subscription on Google Play.

Troubleshooting

Why are my titles in a different font when I open a project created on my mobile device on my desktop?
The text in your titles may appear differently on desktop if the font is missing on desktop. You may have to resolve missing fonts. For more information on resolving font issues, see Resolve missing fonts in desktop applications.

For information on licensing of fonts, see Font licensing.

Why is the project I created using Premiere Rush on mobile not visible in the desktop application?
There may be some syncing issues. Check your internet connection on both mobile and desktop. If the connection seems fine, try out the steps listed in Troubleshoot synchronization issues to resolve the issue.
Feedback

• How do I provide feedback regarding Premiere Rush on mobile?
  
  You can provide feedback to us in the following ways:

  • Tap the Feedback icon in the upper-right corner of your Premiere Rush app to provide feedback. Your feedback will be posted to the Premiere Rush site on UserVoice where the Premiere Rush team will receive and look into your comments.

  • Tweet to us at Adobe Video Creators

• How do I submit feature requests and bugs?
  
  You can influence the future of Premiere Rush on desktop and on mobile! At anytime, you can suggest a feature request on the Premiere Rush site on UserVoice, or upvote existing feature requests. When Adobe updates the status of a feature (for example, when a feature is added to the app, it will be updated to Completed in UserVoice), you get an email with the update.

Create and edit videos using Adobe Premiere Rush on iOS

You can use Premiere Rush seamlessly on your desktop and iOS devices. You have access to the same features across your computer and iOS devices. When you use Premiere Rush on iOS, you can also capture videos with more control right from within the Premiere Rush app.

Premiere Rush syncs all your projects on all of your devices. Any edits you make on your iOS devices are automatically synced to Adobe Premiere Rush on your desktop. For more information, see How project syncing works in Adobe Premiere Rush.

Note:

You need a Creative Cloud membership to sync Premiere Rush projects across all of your devices.

Install and sign in to Premiere Rush on iOS

You can install Premiere Rush from iTunes.

Before installing Premiere Rush, check that your device meets the system requirements.

Link

Once you have completed installation, launch Premiere Rush and sign in:

1 On your iPad or iPhone, tap the Premiere Rush app icon.

2 Sign in with your Adobe ID, Facebook account, or Google account.

Create a new project

After you have launched the app and signed in, tap the plus (+) button at the bottom of the screen to create a new project.

You can then choose Add Media to use already captured media on your device, Creative Cloud, or Dropbox. Or you can directly shoot photos or videos into a new project by tapping on Take Video or Photo.
**Add photos and videos**

To add existing photos or videos to a project, tap **Add Media**. You can select multiple photos, videos, and music clips. The selected clips appear at the bottom of the screen. Once you've made your selections, type in a project name and tap **Create** to import them into your project.

By default, **Sync with CC** is enabled, allowing you to access your project with the most recent changes from all of your mobile and desktop devices.

![Add photos or videos to your project](image)

**Capture photos and videos**

To take photos and videos, use Premiere Rush’s built-in capture functionality instead of using your device’s native camera app.

You can use AUTO mode to set your focus and white balance with just one tap and then shoot. You also have access to a PRO mode with features that give you more control, such as ISO, shutter speed, white balance, resolution, and frame rate.

**Video**

To capture media into a new project, do the following steps:

1. Tap the plus (+) button in Project Browser and then tap **Take Video or Photo**.
2. The camera opens.

   You can use the default AUTO mode for basic capture controls or toggle on PRO mode for more settings, such as shutter speed, white balance, resolution, frame rate, and ISO. For more information on the camera settings, see **Capture options**.

3. Once you’ve defined your capture settings, record video by tapping the red button and capture photos by tapping on the Camera icon next to the red button.
4 When you are done with capturing photos and videos, tap the blue check mark to add your captured media to a new project.

**Capture options**

**AUTO settings**

*The automatic capture options in Premiere Rush*

**Grid** A grid dividing the screen into thirds is overlaid on the screen to be used as a guide while you shoot.

**Flash** You can use one of the following options to turn the flash on or off while shooting:

- Flash Off: Flash never fires when you take pictures or record video.
- Flash Automatic: Flash only fires in low light situations.

**Torch** The flash on the back camera stays turned on, whether you are shooting or not. It is helpful for capturing videos in dark situations where you need extra light.

**PRO settings**

You can manually control the following settings in PRO mode:

**Exposure options**
ISO  ISO controls the sensitivity of your device's camera to light.

Shutter  Shutter speed controls the duration for which your camera is exposed to light. You can adjust this duration to achieve the desired creative effect in your photos and videos.

Exposure Meter  Automatically calculates the level of exposure based on your ISO and shutter settings.

Auto Exposure  If you don’t want to manually control the exposure options, toggle on Auto Exposure.

Exposure Bias

Exposure Bias  Use the Exposure Bias adjustment to either underexpose or overexpose the camera.

White Balance options
PRO white balance options in Premiere Rush

**Temp**  Temperature refers to the warmth or coolness of your shot.

**Tint**  Tint applies a green-to-violet color correction to a shot.

**Auto White Balance**  If you don’t want to manually control the PRO white balance options, slide **Auto White Balance** to the right.

Focus and zoom options

**A**: Focus is the distance between the lens and the image sensor when the subject is in focus.

**B**: If you don’t want to manually control the PRO focus option, toggle on **Auto Focus**.
Zoom option in Premiere Rush

Swipe the slider to the right to zoom in on what you are filming.

Resolution and frame rate

**Resolution**  You can shoot 480p, 580p, 720p, 1080p, or 4K videos using the Premiere Rush camera. The default resolution is 1080p.

**Frame Rate**  Frame rate is the number of individual frames included for each second of video you record. The most common frame rates while shooting video are 24, 25, and 30 frames per second. The default frame rate is 30 frames per second.
If you are not sure which option to select, stick to the default values.

**The Premiere Rush editing workspace**

A: **Home** - Takes you back to the home screen where you can start a new project and view or open all of your projects.

B: **Add Media** - Insert a title, more media, or a voiceover to your project.

C: **Project Assets** - Contains media that has been used recently in the project.

D: **Track Controls** - Allows you to arrange your clips (videos, photos, graphics, and audio) with flexibility.

E: **Orientation** - Choose Landscape, Portrait, or Square for your video.

F: **Feedback** - Give feedback about your experience.

G: **Export** - Save project on device or export it. For more information, see [Export video](#).

H: **Undo** - Reverse a recent change that you have performed. You can also long-press this button to bring up a menu that allows you to choose **Undo** or **Redo**.

**Trim, split, duplicate, or delete clips**
**Trim a clip**

You can fine-tune the duration of a clip in your timeline by moving the clip's start point or end point. This process is called trimming.

To select a clip on the timeline, tap it. Orange handles appear around the clip when it is selected. To trim away a portion of a clip, go to the beginning or end of the clip and tap and hold the thick orange handle and drag it to the right or left.

**Note:**

You are not trimming the original video. You can drag the orange handles outward to extend the trimmed clip.
Split a clip

Splitting clips

Splitting is useful if you have added a clip to a project but don't want to use the entire clip all at once.

To split a clip into two, drag the playhead to the place you want the split to occur. Swipe-right on the bottom toolbar and tap the Scissors icon.

After you split a clip, you can rearrange the two separate clips and move them around your timeline.
Delete or duplicate a clip

Duplicating a clip before editing is a great idea as you can retain the original clip and do "before and after" comparisons while editing.

Long-press a clip on the timeline. In the pop-up menu that appears, tap **Duplicate** to create a copy of the clip. The duplicated clip appears on the timeline after the original clip.

To delete a clip, tap **Delete** from the pop-up menu to remove the clip from the timeline.

Add titles

To add titles to your project, do the following:

1. Move the playhead in your timeline to the point where you want to add a title.
2. Tap the blue + button, and then tap **Title**. A new title clip is added to your timeline at the location of the playhead, and a list of title styles also appears on the screen.
3 Tap a style to apply it to your title. You can also drag a preferred title style from the list and drop it directly into the timeline.

4 (Optional) Tap **More Titles** to open a full-screen window that displays additional title templates available for download from Adobe.
Premiere Rush on iOS and Android

More titles

Edit titles
To customize a title, do the following:

1. Tap the title clip in the timeline to ensure it is selected (you can see the orange handles around it to know that it is selected).
2. To edit text in the preview monitor, double-tap the text to get into editing mode to change the text.

Last updated 11/27/2019
You can edit different layers of the title separately. Tap **Layer** from the bottom bar and select the layer you want to edit from the menu. You can change the font style, size, spacing, and color fill for each individual layer.

![Edit text and shape layers](image)

**Note:**

If you are not satisfied with the available fonts, you can access more fonts from Adobe Fonts. To find more fonts, tap the Creative Cloud icon next to **Add Adobe Fonts** from the **Font** menu. Then tap the **Activate** icon once you choose a font. The font is then added to the font list in Premiere Rush. You can use these activated fonts not just in Premiere Rush but in other Creative Cloud apps as well.

### Add transitions

You can add transitions between clips to blend changes from one video clip to another. The transitions options available are cross dissolve, dip to black, and dip to white.

To add a transition to your clip, do the following:

1. Select a clip from the timeline.
2. Tap the **Transitions** icon.
3. To add a transition to the start and end of a clip, tap a preferred transition style. The transition is applied to the beginning and end of the clip.

**Note:**
You may need to zoom into your timeline to better preview transitions on your clips.

4 To add a transition to only one side of a clip, drag a transition style and place it over the edge of a clip. You can see a white highlighted section on your clip that shows you where the transition will be placed before you drop it. You may need to zoom into your timeline to more easily drag, drop, and preview transitions on your clips.

5 To adjust the duration of the transition, use the duration slider or tap on the transition in the timeline to bring up the orange handles that you can drag in or out to change the duration of the transition.
Adjust color

To add a color preset or filter to a clip in your timeline, do the following:

1. Select the clip in the timeline.
2. Tap the Color icon and select a preset.
3 To adjust the intensity of the preset you have chosen, tap **Intensity** and move the slider left or right to reduce or increase the intensity of the preset.

4 You can also adjust the following settings manually to further enhance the look of your clip (you can do this with or without a preset selected):
   - **Exposure**: Adjust the exposure of the clip.
   - **Contrast**: Adjust the contrast of the clip.
   - **Highlights**: Adjust the brightness of the light areas in the clip.
   - **Shadows**: Adjust the darkness of the darker areas in the clip.
   - **Temperature**: Fine-tune the white balance by moving the slider to the left to make the video appear cooler, and to the right for warmer colors.
   - **Tint**: Fine-tune the white balance by moving the slider to the left to add a green tint and move it to the right to add a magenta tint.
   - **Vibrance**: Adjust the intensity of the more muted colors in the clip with less effect on the higher-saturated colors.
   - **Saturation**: Adjust the saturation of all colors in the clip equally from 0 (monochrome) to 100 (double the saturation).
   - **Faded Film**: Apply a faded film effect to the clip.
   - **Sharpening**: Adjust edge definition to create a sharper-looking video.
   - **Vignette**: Amount: Set the amount of lightening or darkening along the edges of an image.
   - **Feather**: Define the edge of the vignette. A smaller value creates a harder, sharper edge, whereas, a larger value indicates a softer, thicker edge.

5 To revert the adjustments, you made to the preset, tap the **Reset** icon.
6 Toggle the on/off option to view the clip with or without the color adjustments applied to it (preview the look of the clip before and after your color adjustments).

7 To create a preset, tap Options and select Create Preset from the pop-up list. Enter a name and tap Save. Your new custom preset is saved under Your Presets.

Adjust speed

Video

To change the speed of a clip, do the following:

1 Select the clip in the timeline.

2 To open the speed controls, tap the Speed icon.
3 To speed up or slow down a portion of the clip, tap **Range** to reveal a slider with blue handles. Set the start and end points by moving the blue handles to select a specific part of the clip. You can also do this using the blue range handles on the clip in the timeline.
4 If you are unsure of the clip speed that you want, manually edit the clip duration to set a specific duration for your clip and let Premiere Rush determine the right speed changes to make for you - based on that duration. To edit the clip duration, tap the minutes, seconds, or frames values and type in your changes.

5 If the clip contains audio, playing the clip more slowly lowers the pitch of the audio, and playing the clip faster raises the pitch. To preserve the original pitch of the audio, the **Maintain Pitch** check box in the Speed panel is enabled by default. If you don’t want to preserve the pitch, disable this check box.

**Tip:** If the audio isn’t essential, mute the audio track and add background music to the clip.

6 To smooth the transition into your speed range, tap **Ramp** and adjust the **Ramp** duration.

7 To reverse all the speed changes you made to the clip, tap **Reset**.
Add audio

Set the mood for your videos by adding music. You can add music saved on your device or choose from the soundtracks that are included with the app.

1. Tap the plus (+) icon. Then tap Media > Audio.
2. Select the audio clip. The selected clips are shown at the bottom of the screen. Once you have made your selections, tap Add.
3. You can edit your audio clips just like any other clips in your timeline.
   To refine an audio clip, select it in the timeline and tap Audio on the bottom bar to open the Audio controls. To open the Audio controls, double-tap on the audio clip itself in the timeline. You can now access all of the audio refinement tools.
   To learn what you can do with these audio options, see Edit your audio tracks.

Export video

Once rendering is complete, your video is saved to your device (camera roll) and you are ready to share your video on YouTube, Facebook, Instagram, TikTok, or Behance.

For more information on export options while exporting to these social media channels, see Export video.
Export video

Share your video on your YouTube channel
1. Open the project in Premiere Rush.
2. Tap on the Share icon on the title bar.
3. If necessary, adjust the Quality Settings.
4. Tap on Export.
5. Do not close the app or lock your device until rendering is complete.
6. Tap on YouTube.
7. Sign in to YouTube (if you are not already signed in).
8. Add a Title, Description, and Tags to easily surface your video. Set Privacy when shared to Public, Private, or Unlisted. Choose a Category and a Playlist.
9. You can choose to schedule when the video gets published to your YouTube channel by setting a date and time.
10. Tap on Publish.

Share your video on your Facebook page
1. Open the project in Premiere Rush.
2. Tap on the Share icon on the title bar.
3. If necessary, adjust the Quality Settings.
4. Tap on Export.
5. Do not close the app or lock your device until rendering is complete.
6. Tap on Facebook.
7. Sign in to Facebook (if you are not already signed in).
8. You can choose to share the video as a News Feed, as Your Story or Set as Profile Video.
9. Share the video.

If you are exporting your video using Premiere Rush on desktop, see Save, share, or export your video.
Share your video on Instagram
1  Open the project in Premiere Rush.
2  Tap on the Share icon on the title bar.
3  If necessary, adjust the Quality Settings.
4  Tap on Export.
5  Do not close the app or lock your device until rendering is complete.
6  Tap on Instagram.
7  Sign in to Instagram (if you are not already signed in).
8  You can choose to share the video as a Feed, or as Stories.
9  Share the video.

Share your video on TikTok
1  Open the project in Premiere Rush.
2  Tap on the Share icon on the title bar.
3  If necessary, adjust the Quality Settings.
4  Tap on Export.
5  Do not close the app or lock your device until rendering is complete.
6  Tap on TikTok.
7  Sign in to TikTok (if you are not already signed in).
8  Share the video.

Share your video on Behance
1  Open the project in Premiere Rush.
2  Tap on the Share icon on the title bar.
3  If necessary, adjust the Quality Settings.
4  Tap on Export.
5  Do not close the app or lock your device until rendering is complete.
6  Tap on Behance.
7  Sign in to Behance (if you are not already signed in).
8  Add the details Behance requires to easily surface your video.
9  Share the video.
Create and edit videos using Adobe Premiere Rush on Android

You can use Premiere Rush seamlessly on your desktop and Android devices. You have access to the same features across your computer and mobile devices. When you use Premiere Rush on Android, you can also capture videos with more control right from within the Premiere Rush app.

Premiere Rush syncs all your projects on all of your devices. Any edits you make on your Android devices are automatically synced to Adobe Premiere Rush on your desktop. For more information, see How project syncing works in Adobe Premiere Rush.

*Note:*

You need a Creative Cloud membership to sync Premiere Rush projects across all of your devices.

Install and sign in to Premiere Rush on Android

You can install Premiere Rush from Google Play Store. For information on installing or managing your Premiere Rush subscription on Android, see Manage Premiere Rush subscriptions on Android.

Before installing Premiere Rush, check that your device meets the system requirements.

Launch Premiere Rush and sign in:

1. On your Android device, tap the Premiere Rush app icon.
2. Sign in with your Adobe ID, Facebook account, or Google account.

Create a project

After you have launched the app and signed in, tap the plus (+) button at the bottom of the screen to create a project.

You can then choose Add Media to use already captured media on your device, Creative Cloud, or Dropbox. Or you can directly shoot photos or videos into a new project by tapping on Take Video or Photo.

The selected clips appear at the bottom of the screen. Once you've made your selections, type in a project name and tap Create to import them into your project.

Sync with CC enables you to access your project with the most recent changes from all of your mobile and desktop devices. Premiere Rush automatically separates the scenes for you into separate clips on to your timeline.

Add photos and videos

To add existing photos or videos to a project, tap Add Media. You can select multiple photos, videos, and music clips.
Add photos or videos to your project

**Capture photos and videos**

To take photos and videos, use Premiere Rush’s built-in capture functionality, instead of using your device’s native camera app.

You can use AUTO mode to set your focus and white balance with just one tap and then shoot. You also have access to a PRO mode with features that give you more control, such as ISO, shutter speed, white balance, resolution, and frame rate.

To capture media into a new project, do the following steps:

1. Tap the plus (+) button in Project Browser and then tap **Take Video or Photo**.
2. The camera opens.
   
   You can use the AUTO mode for basic capture controls. For advanced settings such as shutter speed, white balance, resolution, frame rate, and ISO, toggle on PRO mode. For more information on the camera settings, see **Capture options**.
3. Once you’ve defined your capture settings, record video by tapping the red button. To capture photos, tap on the Camera icon next to the red button.
4. When you are done capturing photos and videos, tap the blue check mark to add your captured media to a new project.

**Capture options**
**AUTO settings**

![Auto settings image](image)

*The automatic capture options in Premiere Rush*

**A: Grid** A grid dividing the screen into thirds is overlaid on the screen to be used as a guide while you shoot.

**B: Flash** You can use one of the following options to turn the flash on or off while shooting:

- Flash Off: Flash never fires when you take pictures or record videos.
- Flash Automatic: Flash only fires in low light situations.

**C: Torch** The flash on the back camera stays turned on, whether you are shooting or not. It is helpful for capturing videos in dark situations where you need extra light.

**PRO settings**

You can manually control the following settings in PRO mode:

**Exposure options**
PRO exposure options in Premiere Rush

**A: ISO**  ISO controls the sensitivity of your device's camera to light.

**B: Shutter**  Shutter speed controls the duration of light your camera is exposed to. You can adjust this duration to achieve the desired creative effect in your photos and videos.

**C: Auto Exposure**  If you don’t want to manually control the exposure options, toggle on Auto Exposure.

Exposure Bias
Exposure bias in Premiere Rush

**Exposure Bias**  Use the Exposure Bias adjustment to either underexpose or overexpose the camera.

**White Balance options**
PRO white balance options in Premiere Rush

A: Temp  Temperature refers to the warmth or coolness of your shot.

B: Tint  Tint applies a green-to-violet color correction to a shot.

C: Auto White Balance  If you don’t want to manually control the PRO white balance options, slide Auto White Balance to the right.

Focus and zoom options

PRO focus options in Premiere Rush
Focus is the distance between the lens and the image sensor when the subject is in focus. If you don’t want to manually control the PRO focus option, toggle on Auto Focus.

Zoom option in Premiere Rush

Swipe the slider to the right to zoom in on what you are filming.
The Premiere Rush editing workspace

A: Home - Takes you back to the home screen where you can start a new project, and view or open all of your projects.

B: Add Media - Insert a title, more media, or a voice-over to your project.

C: Project Assets - Contains media that has been used recently in the project.

D: Track Controls - Allows you to arrange your clips (videos, photos, graphics, and audio) with flexibility.

E: Orientation - Choose Landscape, Portrait, or Square for your video.

F: Feedback - Give feedback about your experience.

G: Export - Save project on device or export it. For more information, see Export video.

H: Undo - Reverse a recent change that you have performed. You can also long-press this button to bring up a menu that allows you to choose Undo or Redo.

Trim, split, duplicate, or delete clips
**Trim a clip**

You can fine-tune the duration of a clip in your timeline by moving the clip’s start point or end point. This process is called trimming.

To select a clip on the timeline, tap it. Orange handles appear around the clip when it is selected. To trim away a portion of a clip, go to the beginning or end of the clip and tap and hold the thick orange handle and drag it to the right or left.

*Note:*

You are not trimming the original video. You can drag the orange handles outward to extend the trimmed clip.
Split a clip

Splitting is useful if you have added a clip to a project but don't want to use the entire clip all at once.

To split a clip into two, drag the playhead to the place you want the split to occur. Swipe-right on the bottom toolbar and tap the Scissors icon.

After you split a clip, you can rearrange the two separate clips and move them around your timeline.
Delete or duplicate a clip

Duplicating a clip before editing is a great idea as you can retain the original clip and do "before and after" comparisons while editing.

Long-press a clip on the timeline. In the pop-up menu that appears, tap **Duplicate** to create a copy of the clip. The duplicated clip appears on the timeline after the original clip.

To delete a clip, tap **Delete** from the pop-up menu to remove the clip from the timeline.

Add titles

To add titles to your project, do the following:

1. Move the playhead in your timeline to the point where you want to add a title.
2. Tap the blue + button, and then tap **Title**. A new title clip is added to your timeline at the location of the playhead, and a list of title styles also appears on the screen.
3 Tap a style to apply it to your title. You can also drag a preferred title style from the list and drop it directly into the timeline.

4 (Optional) Tap **More Titles** to open a full-screen window that displays additional title templates available for download from Adobe.
Edit titles
To customize a title, do the following:

1 Tap the title clip in the timeline to ensure that it is selected (you can see the orange handles when it is selected).
2 To edit text in the preview monitor, double-tap the text to get into editing mode to change the text.
3 You can edit different layers of the title separately. Tap **Layer** from the bottom bar and select the layer you want to edit from the menu. You can change the font style, size, spacing, and color fill for each layer.

![Edit layers separately](image)

**Note:**

If you are not satisfied with the available fonts, you can access more fonts from Adobe Fonts. To find more fonts, tap the Creative Cloud icon next to **Add Adobe Fonts** from the **Font** menu. Then tap the **Activate** icon once you choose a font. The font is then added to the font list in Premiere Rush. You can use these activated fonts not just in Premiere Rush but in other Creative Cloud apps as well.

**Add transitions**

You can add transitions between clips to blend changes from one video clip to another. The transitions options available are cross dissolve, dip to black, and dip to white.

To add a transition to your clip, do the following:

1 Select a clip from the timeline.
2 Tap the **Transitions** icon.
3 To add a transition to the start and end of a clip, tap a preferred transition style. The transition is applied to the beginning and end of the clip.

**Note:**

You may need to zoom into your timeline to better preview transitions on your clips.
4 To add a transition to only one side of a clip, drag a transition style and place it over the edge of a clip.

You can see a white highlighted section on your clip that shows you where the transition will be placed before you drop it. You may need to zoom into your timeline to more easily drag, drop, and preview transitions on your clips.

5 To adjust the duration of the transition, use the duration slider or tap on the transition in the timeline to bring up the orange handles that you can drag in or out to change the duration of the transition.
Adjust color

To add a color preset or filter to a clip in your timeline, do the following:

1. Select the clip in the timeline.
2. Tap the **Color** icon and select a preset.
3 To adjust the intensity of the preset you have chosen, tap **Intensity** and move the slider left or right to reduce or increase the intensity of the preset.

4 You can also adjust the following settings manually to further enhance the look of your clip (you can do this with or without a preset selected):

- **Exposure**: Adjust the exposure of the clip.
- **Contrast**: Adjust the contrast of the clip.
- **Highlights**: Adjust the brightness of the light areas in the clip.
- **Shadows**: Adjust the darkness of the darker areas in the clip.
- **Temperature**: Fine-tune the white balance by moving the slider to the left to make the video appear cooler, and to the right for warmer colors.
- **Tint**: Fine-tune the white balance by moving the slider to the left to add a green tint and move it to the right to add a magenta tint.
- **Vibrance**: Adjust the intensity of the more muted colors in the clip with less effect on the higher-saturated colors.
- **Saturation**: Adjust the saturation of all colors in the clip equally from 0 (monochrome) to 100 (double the saturation).
- **Faded Film**: Apply a faded film effect to the clip.
- **Sharpening**: Adjust edge definition to create a sharper-looking video.
- **Vignette**: Amount: Set the amount of lightening or darkening along the edges of an image.
- **Feather**: Define the edge of the vignette. A smaller value creates a harder, sharper edge, whereas, a larger value indicates a softer, thicker edge.
5 To revert the adjustments, you made to the preset, tap the **Reset** icon.

6 Toggle the on/off option to view the clip with or without the color adjustments applied to it (preview the look of the clip before and after your color adjustments).

7 To create a preset, tap **Options** and select **Create Preset** from the pop-up list. Enter a name and tap **Save**.

Your new custom preset is saved under **Your Presets**.

---

**Adjust speed**

To change the speed of a clip, do the following:

1 Select the clip in the timeline.

2 To show the speed controls, tap the **Speed** icon.

3 To speed up or slow down a portion of the clip, tap **Range** to reveal a slider with blue handles. Set the start and end points by moving the blue handles to select a specific part of the clip. You can also do this using the blue range handles on the clip in the timeline.
If you are unsure of the clip speed that you want, manually edit the clip duration to set a specific duration for your clip and let Premiere Rush determine the right speed changes to make for you - based on that duration. To edit the clip duration, tap the minutes, seconds, or frames values and type in your changes.

If the clip contains audio, playing the clip more slowly lowers the pitch of the audio, and playing the clip faster raises the pitch. To preserve the original pitch of the audio, the Maintain Pitch check box in the Speed panel is enabled by default. If you don’t want to preserve the pitch, disable this check box.

Tip: If the audio isn’t essential, mute the audio track and add background music to the clip.

To smooth the transition into your speed range, select Ramp and adjust the ramp duration.

To reverse all the speed changes that you made to the clip, tap Reset.
Add audio

Set the mood for your videos by adding music. You can add music saved on your device or choose from the soundtracks that are included with the app.

1 Tap the plus (+) icon. Then tap Media > Audio.

2 Select the audio clip. The selected clips are shown at the bottom of the screen. Once you've made your selections, tap Add.

3 You can edit your audio clips just like any other clips in your timeline.

   To refine an audio clip, select it in the timeline and tap Audio on the bottom bar to open the Audio controls. To open the Audio controls, double-tap on the audio clip itself in the timeline. You can now access all of the audio refinement tools.

   To learn what you can do with these audio options, see Edit your audio tracks.

Export video

Once rendering is complete, your video is saved to your device and you are ready to share your video on YouTube, Facebook, Instagram, TikTok, or Behance.

For more information on export options while exporting to these social media channels, see Export video.
Manage Adobe Premiere Rush subscriptions on iOS

Adobe Premiere Rush is available on a variety of iOS devices. For a list of supported phones and tablets, see System requirements.

Download and install Premiere Rush on iOS

You can download Premiere Rush from the Apple App store for free and sign up for your free starter plan that includes:

- Three exports
- 2GB of cloud storage and
- Access to Adobe Fonts and Adobe Portfolio

Link

Download Adobe Premiere Rush for iOS

Upgrade to a paid Premiere Rush subscription

Note:
You do not need to upgrade your Premiere Rush subscription if you already have a paid plan that includes Premiere Pro, such as the Premiere Pro single app subscription or the all apps Creative Cloud subscription.

1 Tap the Settings icon in the Premiere Rush app.
Premiere Rush on iOS and Android

2 Choose **Upgrade Rush** from the Settings menu.
3 Tap Upgrade.
4 Tap the **Buy Now** button.
Premiere Rush on iOS and Android

Upgrade for unlimited sharing and 100GB of storage for
[price]/ month

Buy Now

This payment will be charged to your iTunes account. For more information see Adobe's Terms Of Use and Privacy Policy.

Buy a Premiere Rush subscription

5 Sign in using your Apple ID and tap Confirm to buy the subscription.
Your Premiere Rush subscription (if purchased through the Apple App Store) is billed through Apple. You can view, change, or cancel your subscriptions through the App Store. You can do this on any Apple device such as an iPhone, iPad, Mac, or Apple TV.

**Note:**

If you no longer have an Apple device, download iTunes on a PC or contact Apple Support to cancel your subscriptions. For more information, see the Apple documentation.

1. Open the App Store app.
2. Tap on your profile image on the top-right corner.

**Note:**

If you cannot find your profile image, locate and tap on your Apple ID.
3 Click your account name, and sign in using your Apple ID (if prompted).
Accessing your Apple account using your Apple ID

4 Scroll to the **Subscriptions** link, then tap it.

5 Tap your Premiere Rush subscription to access your subscription details.
6 Tap **Cancel**. In the screen that appears tap **Confirm** to confirm you want to cancel the subscription.
Manage Adobe Premiere Rush subscriptions on Android

Premiere Rush is available on a variety of Android phones and is available for download from the Google Play Store and the Samsung Galaxy Store.

For a list of supported handsets, see System requirements.

Download and install Premiere Rush on Android

You can download a trial version of Premiere Rush for free (this plan offers you three exports and 2GB of cloud storage).
Upgrade to a paid Premiere Rush subscription

Note:

If you have the all apps Creative Cloud subscription or the Premiere Pro single app subscription, you don’t have to purchase Premiere Rush; it’s already included in your plan.

1  Tap the Settings icon in the Premiere Rush app.

2  Tap Upgrade Rush.
3 Tap Buy Now.

**Cancel Premiere Rush subscription**

<table>
<thead>
<tr>
<th>Store</th>
<th>Cancel instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchased from Google Play Store?</td>
<td>See <a href="https://support.google.com/takeover/answer/9489964?hl=en">Cancel, pause, or change a subscription on Google Play.</a></td>
</tr>
</tbody>
</table>
| Purchased from Samsung Galaxy Store?       | 1 Launch the Samsung Galaxy Store from your device.  
2 Tap More Options > My Apps > Receipts > Items.  
3 Scroll down and tap Unsubscribe.  
If you no longer have a Samsung device, contact Samsung to cancel your Rush subscription. |
Manage Adobe Premiere Rush subscriptions on Samsung Galaxy Store

Adobe Premiere Rush is available on Samsung phones. For a list of supported Samsung handsets, see System requirements.

Download and install Premiere Rush on Samsung phones

Download Adobe Premiere Rush from Samsung Galaxy Store.

Upgrade to a paid Premiere Rush subscription

Note:

You do not need to upgrade your Premiere Rush subscription if you already have a paid plan that includes Premiere Pro, such as the Premiere Pro single app subscription or the all apps Creative Cloud subscription.

1 Tap the Settings icon in Premiere Rush.

The Settings icon in Premiere Rush

2 Choose Upgrade Rush from the Settings menu.
3 Tap **Upgrade**. You are taken to the Samsung Galaxy Store where you can buy your subscription.

4 Log in to your Samsung account. Your billing data is stored in this account.
5 Review your subscription and payment details, then tap **Buy** to purchase your Premiere Rush subscription.
Buying your Premiere Rush subscription from the Samsung Galaxy Store

Cancel your Premiere Rush subscription

1 Open the Samsung Galaxy Store app.
2 Tap More Options > My Page > Receipts > Items. Then select Premiere Rush.
Select your Premiere Rush subscription

3 Tap Unsubscribe.
Canceling a Premiere Rush subscription from the Samsung Galaxy Store

4 Tap **Unsubscribe** again to confirm that you want to cancel.
Confirm that you want to cancel your Premiere Rush subscription